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Preface

Audience

The purpose of this document is to provide you with an overview of the possibilities
offered by SAP BW Knowledge Modules and how to use them in Oracle Data
Integrator.

This document provides examples to help you understand how to approach an ETL
project with Oracle Data Integrator, loading a Data Warehouse with data from SAP BW
systems, while validating data quality.

This project should take approximately 90 minutes to complete. You may save your
work in order to pause and resume at any point in the project.

It is recommended that you use Oracle Data Integrator before proceeding with this
guide. A good introduction to Oracle Data Integrator is the guide Data Integrator
Getting Started.

It is recommended that you also review the SAP ABAP - BW chapter of Application
Adapters Guide for Oracle Data Integrator for more information about the SAP BW
KMs.

This document is intended for developers and administrators who want to use Oracle
Data Integrator Application Adapters with SAP BW systems using SAP JCo libraries,
as a development tool for their integration processes.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the
Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/
lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
if you are hearing impaired.

Related Documents

ORACLE

For more information, see the following documents in Oracle Data Integrator Library.

* Release Notes for Oracle Data Integrator

* Understanding Oracle Data Integrator
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*  Administering Oracle Data Integrator

*  Developing Integration Projects with Oracle Data Integrator
» Installing and Configuring Oracle Data Integrator

*  Upgrading Oracle Data Integrator

*  Application Adapters Guide for Oracle Data Integrator

*  Developing Knowledge Modules with Oracle Data Integrator

e Connectivity and Knowledge Modules Guide for Oracle Data Integrator
Developer's Guide

*  Migrating From Oracle Warehouse Builder to Oracle Data Integrator

*  Oracle Data Integrator Tools Reference

» Data Services Java API Reference for Oracle Data Integrator

*  Open Tools Java API Reference for Oracle Data Integrator

e Java API Reference for Oracle Data Integrator

*  Getting Started with SAP ABAP ERP Adapter for Oracle Data Integrator

*  Oracle Data Integrator 12c¢ Online Help, which is available in ODI Studio through
the JDeveloper Help Center when you press F1 or from the main menu by
selecting Help, and then Search or Table of Contents.

Conventions

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

nonospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.
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Overview of Oracle Data Integrator SAP
BW Knowledge Modules

This chapter provides an overview of Oracle Data Integrator SAP BW Knowledge
Modules.

1.1 Overview

The Oracle Data Integrator SAP BW Knowledge Modules provide integration from
SAP BW systems using SAP JCo libraries. This set of KMs has the following features:

ORACLE

Reads SAP data from SAP BW system
Loads this SAP data into Oracle / non-Oracle Staging Area

Reverse-engineers metadata of warehouse and proposes a tree browser to pick
up only the required metadata

This adapter includes two knowledge modules:

RKM SAP BW: Its main role is to perform customized reverse-engineering of SAP
BW data targets into ODI datastores (Models). The SAP BW RKM is in charge

of connecting to the SAP BW System, which provides the SAP BW data target's
metadata information, and transforming and writing the resulting metadata into
Oracle Data Integrator's repository.

The LKM SAP BW to Oracle (SQLLDR)/LKM SAP BW to SQL connects to

SAP BW and retrieves data targets defined in the SAP Model. It is used in the
mappings. The LKM is in charge of loading source data from a SAP BW System to
an Oracle/non-Oracle staging area.
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Setting Up the Environment

This chapter describes how to set up your SAP BW environment for use with Oracle
Data Integrator.
This chapter includes the following sections:

2.1 Before You Begin

Before you begin, consider the following:

2.1.1 System Requirements and Certification

Before performing any installation you should read the system requirements and
certification documentation to ensure that your environment meets the minimum
installation requirements for the products you are installing.

The Oracle Data Integrator requirements are listed in Installing and Configuring Oracle
Data Integrator.

The requirements specific to the Oracle Data Integrator SAP ABAP - BW Adapter are:

ORACLE

Oracle Data Integrator 11.1.1.7.0 or above.

A Java Connector (JCo) version compatible with adapter must be used. The list of
supported JCo versions is available in the Compatibility Matrix available from My
Oracle Support. A minimum version of JCo 3.0.2 is required.

A JVM version compatible with both Oracle Data Integrator and JCo must be used.
A minimum version of JVM 1.5 is required due to JCo pre-requisites.

The connector supports two transfer modes for transferring data from SAP system
to the ODI agent: data transfer using a Shared Directory and data transfer through
FTP. For details and restrictions see File Transfer Considerations of Application
Adapters Guide for Oracle Data Integrator. Depending on the chosen file transfer
mode the following requirements must be met:

— Data transfer through a Shared Directory (recommended transfer
method) The LKM SAP BW to Oracle (SQLLDR) requires a folder that is
shared between the SAP system and the ODI agent. The SAP application
server transfers the data by writing it out into a folder that is accessible from
the SAP system and the ODI agent machine. This is typically done by sharing
a folder of the ODI agent machine with the SAP system. Note that the shared
folder does not necessarily have to be located on the ODI agent machine. A
shared folder on a third machine is also possible, as long as the shared folder
is accessible to both the ODI agent machine and the SAP system.
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< Note:

For security reasons, the SAP folders should not be shared with the
ODI agent. Share only folders of the ODI agent machine with the
SAP system.

The shared folder must be accessible to SAP system and not just to the
underlying operating system. This means that the folder needs to be declared
in SAP transaction AL11 and the folder opens successfully in AL11.

— Data transfer through FTP LKM SAP BW to Oracle (SQLLDR) requires a
FTP server to upload data from the SAP BW system. This data is either
read locally by the agent executing the mapping (when this agent runs on the
FTP server machine), or remotely (when this agent is located on a different
machine than the FTP server). This FTP server must be accessible over the
network from both the SAP BW machine and the agent machine.

e For LKM SAP BW to Oracle (SQLLDR) only: SQLLoader is required on the
machine running the agent. SQLLoader is used for loading data extracted from
SAP BW system to the Oracle staging area.

2.1.2 Requesting ODI SAP Component Installation into the SAP

System

The ODI SAP adapter communicates with the SAP System using a few ODI SAP
RFCs. These RFCs are installed by your SAP Basis team using SAP Transport
requests. Please contact your SAP administrators for installing the ODI SAP
Components and assigning the required SAP user authorizations by following the
instructions given in the Installing ODI SAP Components section in Application
Adapters Guide for Oracle Data Integrator.

2.1.3 Requesting FTP Server Access

ORACLE

This section applies only if you plan to transfer data using FTP. You can skip this
section if you use a Shared Directory for the data transfer or if your SAP system is
older than the following:

e SAP ECC6 EHP6 or later
e SAP BWI/BI 7.4 or later

The following steps must be performed before any subsequent steps in this guide can
be performed. These steps are typically performed by your SAP Basis team. Failure
to perform these setup instructions will lead to FTP failure when running any ODI SAP
extraction jobs.

To request FTP server access:
1. Login to SAP server.

2. Execute transaction SE16.

3. Enter SAPFTP_SERVERS in the Table Name field and click [ icon to create entries.
4. Enter IP address of the FTP server in the FTP_SERVER_NAME field.
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Chapter 2
Validating the Shared Folder Setup

5. Enter port of the FTP server in the FTP_Server_Port field.

]
6. Click icon to save.

2.1.4 Gathering SAP Connection Information

In order to connect to the SAP BW system, you must request the following information
from your SAP administrators:

 SAP BW System IP Address or Hosthame: IP address/ Hostname is the
technical name given to the host on which SAP is running.

*  SAP User: SAP User is the unique user name given to a user for logging on the
SAP BW System.

* SAP Password: Case-sensitive password used by the user to log in.

* SAP Language: Code of the language used when logging in For example: EN for
English, DE for German.

*  SAP Client Number: The three-digit number assigned to the self-contained unit
which is called Client in SAP. A Client can be a training, development, testing or
production client or represent different divisions in a large company.

*  SAP System Number: The two-digit number assigned to a SAP instance which is
also called Web Application Server or WAS.

* SAP System ID: The three-character, unique identifier of a SAP system in a
landscape.

* SAP Transport Layer Name: This string uniquely identifies a transport layer in a
SAP landscape. It allows ODI to create transport requests for later deployment in
SAP. Even though there is a default value here, this transport layer name must be
provided by your SAP Basis team. Not doing so may result in significant delays
during installation.

e SAP BW Version: BW 3.5 or Bl 7.0.

*  SAP Character Set: The character set is only required if your SAP system is not
a UNICODE system. For a complete list of character sets, see "Locale Data" in
the Oracle Database Globalization Support Guide. For example, EE8] SO8859P2 for
Croatian Data. For UNICODE systems, use UTF8.

¢ Note:

All the connection data listed above (except SAP SNC Connection Properties
and SAP Router String) are mandatory and should be requested from the
SAP Administrators. You may consider requesting support during connection
setup from your SAP administrators.

2.2 Validating the Shared Folder Setup

ORACLE

Validating a shared folder setup applies only if you plan to transfer data using a Shared
Directory. This section can be skipped, if the FTP transfer is used. The validation of the
shared folder setup needs to be performed before any subsequent steps in this guide
can be performed. This validation is typically performed by your SAP Basis team.
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Step 1: Validating folder access from the SAP application server

g H @ b P

6.

Start the SAPGUI.

Use the ODI SAP user and password to connect to the SAP system and client.
Go to transaction AL11.

Select the shared folder.

Double-click the shared folder to test the directory declaration.

This should report a successful connection. If not, please contact your SAP basis
team. Do not continue until this test passes.

# Note:

SAP uses the OS user <sid>adm to connect to the directories declared
in AL11.

Print screen.

Step 2: Validating folder access from the ODI agent machine

1.

Log in to the ODI agent machine using the Windows user ID used for executing
the ODI agent.

Open shared directory path in Windows Explorer.

This should list the content of the shared folder. Please make sure that you do
NOT need to enter any credentials. If this does not work or you had to enter
credentials, please contact your windows administrator or the system administrator
of the system your shared folder is physically located on. Do not continue until this
test passes.

Print screen.

2.3 Validating the FTP Setup

Validating an FTP setup applies only, if you plan to transfer data using FTP. This
section can be skipped, if you use a Shared Directory for the data transfer. The
validation of the FTP setup needs to be performed before any subsequent steps in
this guide can be performed. This validation is typically performed by your SAP Basis
team.

ORACLE

Step 1: Validating SAPFTPA destination

e o p W NP

Start the SAPGUI.

Use the ODI SAP user and password to connect to the SAP system and client.
Go to transaction SM59.

Expand TCP/IP connections.

Open the SAPFTPA destination.

Click Testconnection.
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Chapter 2
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This should report a successful connection. If not, please contact your SAP basis
team. Do not continue until this test passes.

Print screen.

Step 2: Testing FTP connection

® N o o k~ w NP

Go to transaction SE38.

View the function module RSFTPO002.

Hit F8 to run the ABAP program.

Enter the FTP userID and password.

Enter the FTP server host name or IP address.
Entercd/orcd <ODI target directory>.

In the RFC_DESTINATION field, enter SAPFTPA.
Hit F8 to run the test.

This should report a successful connection. The message should be similar to the
following:

250 QWD successful .

If this test is not successful, please contact your SAP basis team. Do not continue
until this test passes.

Print screen.

2.4 Validating SAP Privileges

This section describes how to test some of the key SAP privileges. Proceed with the
subsequent steps in this guide only after successful validation of these tests. This
validation is typically performed by your SAP Basis team.

Perform the following steps to validate whether a SAP user has appropriate dev rights
and owns a dev license key:

6.

CUE S

Start SAPGUI.

Use the ODI SAP user and password to connect to the SAP system and client.
Go to transaction SE38.

Enter any sample program name like ZSAP_TEST in the program name field.
Click Create.

Perform similar tests for the transaction SE37 and SE11.

If a transaction allows the creation of a program without asking for any key or other
authorization message, then the SAP user has validated that it has the appropriate
dev rights and license key. Otherwise your SAP basis team needs to register the SAP
user in service.sap.com to get the license key and a Basis person can help him with
dev rights.

ORACLE
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2.5 Validating SAP Transport Layer Name

As the SAP connector creates SAP objects, such as, for example, function modules,
into the SAP development system, these changes need to be transported into QA and
production systems once the development is done. The SAP's change and transport
system uses the SAP Transport Layer Name to identify the route a change has to take.
A transport layer is assigned to each development class and thus to all objects in that
class. The transport layer determines:

* In which SAP System developments or changes to the repository objects are
made

» If objects are transported to other systems within the group when development
work has been completed

A consolidation route is created from the development system to the quality assurance
system through the t ransport |ayer Z<SI D>. It then becomes the standard transport
layer for customer development and customizing.

A consolidation route is created from the development system to the quality assurance
system through the t ransport | ayer SAP for the transport of SAP Standard objects.

It is important to specify the correct transport layer name before running the RKM SAP
BW for the first time. Perform the following steps to identify the list of defined transport
layers in your SAP landscape:

1. Log onin client 000 in the SAP System serving as the transport domain controller
via transaction STMS.

2. Select Overview > Transport Routes. The Display Transport Routes dialog is
displayed.

Select Goto > Graphical Editor.
To switch the mode, select Configuration > Display <-> Change.

Position the cursor on the SAP System.

o o p W

Select Edit > System > Change. The Change System Attriburtes dialog is
displayed.

7. Select the StandardTransport Layer tab.
8. Change the transport layer of the SAP System.
9. The result is the list of the different transport Layers.

By default, the RKM option SAP_TRANSPORT_LAYER_NAME is set to SAP. Ask
your SAP basis admin which transport layer you should use. This transport layer
name must be set on the SAP_TRANSPORT_LAYER_NAME RKM option. A wrong or
invalid transport layer name will cause serious delays during the installation process.

2.6 Installing Oracle Data Integrator

Before starting with this project, you need to install and configure Oracle Data
Integrator. See the Data Integrator Getting Started and the Installing and Configuring
Oracle Data Integrator for more information.
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2.7 Installing and Configuring the Oracle DB Target

ORACLE

This project uses an Oracle database engine as the target and as the staging area for
the mappings. You can download for example an Oracle XE database from the Oracle
Technology Network (OTN). Install and configure this database.

This project targets an Oracle table that can be created using the following script:

-- Create deno target schema

CREATE USER CDI _SAP_DEMO | DENTI FI ED BY ODI _SAP_DEMO DEFAULT TABLESPACE USERS
TEMPORARY TABLESPACE TEMP;
GRANT CONNECT, RESOQURCE TO ODI _SAP_DEMO,

-- Create deno target tables
-- For ODS/ DSO

CREATE TABLE ODI_SAP_DEMO. W PURCH DS (
PO GUI D VARCHAR2( 100) ,

ORDER | TEM GUI D VARCHAR2( 100)
ACC_ASS_GU D VARCHAR2( 100) ,

GUI DE_CONTRCT VARCHAR2( 100) ,

ORDER QUANT NUMBER,

NET_PRI CE NUMVBER,

PRICE_UNI T CHAR(5),

NO_OF_PURCH CDR NUMBER) ;

ALTER TABLE ODI_SAP_DEMO. W PURCH DS ADD CONSTRAI NT PK_W PURCH DS PRI MARY KEY
(POGUD);

-- For INFO OBJECT

CREATE TABLE ODI _SAP_DEMD. W ACCNT VENDR DS (

VENDOR CHAR( 10),

PCOVPANY CHAR(10),

PHONE CHAR( 20) ,

PLANT CHAR( 10),

STREET VARCHAR( 50) ,

MED_DESC VARCHAR(100));

ALTER TABLE ODI _SAP_DEMO. W ACCNT VENDR DS ADD CONSTRAI NT PK_W ACCNT VENDR DS
PRI MARY KEY (VENDOR) ;

-- For INFO OBJECT H ERARCHY

CREATE TABLE ODI _SAP_DEMD. W GL_ACCOUNT HI ER DS (
H ER_NAVE CHAR(50),

NODEI D NUMBER( 20) ,

| NFOOBJECT NAME CHAR( 80)

NODENAME CHAR( 80)

TLEVEL NUMBER(5),

PARENTI D NUVBER( 20) ,

CHI LDI D NUMBER( 20) , NEXTI D NUMBER( 20) ) ;

ALTER TABLE ODI _SAP_DEMO W GL_ACCOUNT HI ER DS ADD CONSTRAI NT
PK_W GL_ACCOUNT H ER DS PRI MARY KEY (HI ER_NAME, NODEID);

-- For I'NFO OBJECT I NTERVAL HI ERARCHY
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CREATE TABLE TARGET | NTERVAL_HI ERARCHY
(

RSHI ENM VARCHAR2(30 BYTE)
NODEI D NUNMBER( 8) ,

PARENTI D NUMBER( 8)

I NTERVL VARCHARZ(1 BYTE)
LEAFFROM VARCHAR2( 60 BYTE),
LEAFTO VARCHAR2( 60 BYTE),
VERSI ON VARCHAR2( 3 BYTE),
CHRT_ACCTS VARCHAR2(4 BYTE),
GL_ACCOUNT VARCHAR2(10 BYTE),
BAL_FLAG VARCHAR2(1 BYTE),
GLACCEXT VARCHAR2( 18 BYTE),

| NCST_FLAG VARCHAR2(2 BYTE)

)

-- For I NFO CUBE

CREATE TABLE ODI _SAP_DEMD. W VENDR BAL DS (
OCOVP_CODE CHAR(6) ,

OCREDI TOR CHAR( 10)

ORC_ACCOUNT CHAR( 10)

TOT_DEBT_POST NUMBER,

TOT_CR_POST NUMBER,

CUMULATI VE_BAL NUMBER);

ALTER TABLE ODI _SAP_DEMO. W VENDR BAL_DS ADD CONSTRAI NT PK_W VENDR BAL_DS PRI MARY
KEY ( QCOVP_CQDE);

-- For INFO CUBE & | NFO OBJECT Join

CREATE TABLE ODI_SAP_DEMO. W VENDER CUBE_OBJ DS (
COVP_CODE CHAR( 10),

VENDOR CHAR( 10) ,

GL_ACCOUNT CHAR( 10),

SALES_FOR PERI OD NUMBER,

CUM BALANCE NUMBER,

PLANT CHAR( 10),

MEDI UM DESC VARCHAR2( 100));

ALTER TABLE ODI _SAP_DEMO. W VENDER CUBE_OBJ_DS ADD CONSTRAI NT
PK_W VENDER_CUBE_OBJ_DS PRI MARY KEY (COMP_CODE);

CREATE TABLE "TARGET NAVI GATI ONAL_ATTRI BUTES"
(

| OPK_CUSTOMER VARCHAR2( 10 BYTE),
| OPKCUST _GROUPVARCHAR2( 2 BYTE),

| OPKPK_CUSTOMERVARCHAR( 10 BYTE),
| OPK_PK_PLANT VARCHAR2(4 BYTE),

| OPKCALMONTH NUMBER( 6) ,

| OPK_CALVEEK NUMBER(6) ,

| OPKTHI P_POI NTVARCHAR2( 4 BYTE),
REQUI DVARCHAR2( 30 BYTE),
KF_ODEL_VOL NUMBER(17, 3),

KF_OSHI PDATE NUMBER(17),
KF_OLOADDATEK NUVBER( 17),
KF_QACT G _DTKNUMVBER( 17),
KF_OVATAV_DATKNUVBER( 17) ,
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KF_OLATE_QTY NUMBER(17, 3),
CUSTOVERVARCHAR2( 10 BYTE),
PLANT VARCHAR2(4 BYTE),
PHONE VARCHAR2( 16 BYTE),
PCOVPANYVARCHAR2( 6 BYTE) ,
QUTL_TYPEVARCHAR2( 4 BYTE),
NI ELSEN_| D VARCHAR2(2 BYTE),
LOGSYSVARCHAR2( 10 BYTE),

VI SI T_RYTVARCHAR2( 4 BYTE),
USAGE_| NDVARCHAR2( 3 BYTE),
SRCI D VARCHAR2(4 BYTE),
PRECI S| DNUVBER( 4) ,
POSTCD_BOX VARCHAR2(10 BYTE),
CUS_F_CONS VARCHAR?(1 BYTE),
COUNTRYVARCHAR2( 3 BYTE)
BPARTNERVARCHAR2( 10 BYTE)
ACCNT_GRPVARCHAR2( 4 BYTE)
LANGU VARCHAR2(1 BYTE),
KEYACCOUNT VARCHAR2(1 BYTE)

)

-- For OPEN HUB DESTI NATI ON

CREATE TABLE ODI_SAP_DEMD. W OPENHUB_SALES DS (
OHREQUI D NUMBER,

DATA PACKAGE NUMBER

DATA_RECORD NUMBER,

CUSTOVER CHAR( 1),

MATERI AL CHAR(1),

MATERI AL_PRI CE NUNMBER,

CURRENCY NUNBER,

QUANTI TY NUMBER,

TOTAL_REVENUE NUMBER) ;

ALTER TABLE ODI _SAP_DEMD. W OPENHUB_SALES DS ADD CONSTRAI NT PK_W OPENHUB_SALES DS
PRI MARY KEY (OHREQUID);

2.8 Installing and Configuring JCo

The SAP adapter uses Java Connector (JCo) to connect to the SAP system. JCo must
be configured before proceeding with the project.

To install and configure JCo:

1. Download a supported JCo version for your configuration from http://
service.sap.com/connectors. Check the supported JCo version in the Certification
Matrix available at My Oracle Support. Note that a minimum version of JCo 3.0.2
is required.
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< Note:

e Choose the SAP JCo package matching your operating system and
your system architecture (32/64Bit). E.g. if you are running ODI
inside a 32-Bit JVM, you must download the 32-Bit SAP JCo, even
if the CPU and OS are 64-Bit. Mixing 32-bit and 64-bit architecture
is not possible due to native libraries required by SAP JCo and will
result in connection failure.

e odi.conf contains the JDK path used for ODI Studio.

2. Unzip the appropriate distribution package into an arbitrary directory <sapj co-

instal | - pat h>.

3. Follow the installation instructions in <sapj co-i nst al | - pat h>/ j avadoc/

installation.htn for the respective platform.

4. Copy sapj co3.jar and sapjco3.dl|:

For ODI 10g: Copy sapj co3. j ar and sapj co3. dl | (or respective binary like
| i bsapj co03. so) into the oracl edi / dri vers directory.

For ODI 11g: Copy sapj co3.j ar and sapj co3. dl | (or respective binary like

|'i bsapj co03. so) into the <CDI _HOVE>/ odi _mi sc directory (ODI Studio) and into the
<ODI _HOVE>/ or acl edi / agent / dri vers directory (Standalone Agent) and into the
<WLS_DOMAIN>/lib directory (JEE Agent).

For ODI 12c: Copy sapj co3. j ar and sapj co3. dl | (or respective binary like
|'i bsapj co3. s0) into the <ODI _HOVE>/ odi / sdk/ | i b directory (ODI Studio, ODI
Standalone Agent) and into the <WLS_DOMAIN>/lib directory (JEE Agent).

5. Restart ODI Studio and any agents.

6. Check the JCo installation. This will be also checked later in this guide.

2.9 Configuring Oracle Data Integrator

Perform the following steps to configure Oracle Data Integrator:

2.9.1 Add the Open Tool

ORACLE

The complete process of installing and adding an Open Tool to ODI is described
in Oracle Data Integrator Tools Reference. This section details only the SAP ABAP
specific steps.

1. Connect to Designer.
2. Select ODI > Add/IRemove Open Tools...

3. In the Add/remove Open Tools window, enter the following name in the Open Tool
class name field: or acl e. odi . sap. km _Qdi SapAbapExecut eSt oppabl e.

4. Click Add Open Tool.

5. The Open Tool appears as shown below.
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-

o Add Opén Tools [=]

To add an OpenTool, please add your OpenTool's JAR or ZIP files to '<ide,user. dir > foracledijuserib’ folder, then restart Oracle
Data Integrator. Please find <ide.user.dir> property in Properties tab of Help|About section.

| 4 @

% _0disAPAbapExecute "-UPLOAD =<upload option>" "-EXECUTE=<execute option:> 'Emerwider Orade.

This Open Tool will upload an ABAP program and also Extracts the data from SAP Systems, Version  10.1.3.16
To delete this Open Tool, dlick Delete. Delete
Help oK | Cancel
4
6. Click OK.
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This chapter describes how to configure the topology by using a practical example.
This project demonstrates how to extract data from the SAP BW data targets listed
below:

ODS/DSO:

Source data target 0BBP_PO from SAP BW is the ODS containing vendor
information.

Target W_PURCH_DS is a table in an Oracle database that needs to be loaded
from the SAP BW Sources. This table contains purchase order info.

Info Object:

Source data target OCREDITOR is the Info object from SAP BW containing
Account number of supplier/vendor.

Target W_ACCNT_VENDR_DS is a table in an Oracle database that needs to be
loaded from the SAP BW Sources. This table contains account number info of
supplier/vendor.

Info Object Hierarchy:

Source data target 0GL_ACCOUNT is the Info object from SAP BW containing
General Ledger Information.

Target W_GL_ACCOUNT_HIER_DS is a table in an Oracle database that needs
to be loaded from the SAP BW Sources. This table contains account number info
of supplier/vendor.

Info Cube:

Source data target OFIAP_C20 is the Info cube from SAP BW containing vendor
balances.

Target W_VENDR_BAL_DS is a table in an Oracle database that needs to be
loaded from the SAP BW Sources. This table contains vendor balances.

Info Cube & related Info Objects:

Source data targets OFIAP_C20 and OCREDITOR are the Info Cube & Info Object
respectively both containing the vendor related information.

Target W_VENDER_CUBE_OBJ_DS is a table in an Oracle database that needs
to be loaded from the SAP BW Sources as per join condition.

Open Hub:

Source data target ZOHD_SALE is an Open Hub destination name and its
associated table is /BIC/OHZOHD_SALE which contains the sales information.

Target W_OPENHUB_SALES_DS is a table in an Oracle database that needs to
be loaded from the SAP BW Sources. This table contains sales information.

Delta Extraction:
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For delta Extraction you need to pass the value for two KM options i.e.
FIRST_REQ_ID and LAST_REQ_ID from any above said data targets except Info
Object after full load. The FIRST_REQ_ID is the start point of Delta Extraction and
LAST_REQ_ID is the end point of Delta Extraction.

This chapter includes the following sections:

3.1 Configuring the File Server for SAP ABAP

Perform the following operations after installing or upgrading your Oracle Data
Integrator version:

1.
2.

Connect to Topology Manager.

If this SAP ABAP technology does not exist in your Master Repository, import
the SAP ABAP technology in Synonym INSERT_UPDATE mode from the /i npexp
folder.

Perform an upgrade of the Master Repository. Refer to the Installing and
Configuring Oracle Data Integrator for more information on the Master Repository
upgrade process.

In Topology Manager, open the JavaBeanShell technology and check on the
Language tab that the JYTHON language is listed. If not, add it.

Create a File data server pointing to an existing FTP/file server into which the
extraction file will be pushed from SAP and picked up for SQL*Loader. For
use with FTP transfer, set the following parameters. For use with shared folder
transfer, the settings on the data server do not matter.

* Host (Data Server): FTP server IP host name or IP address.
* User: Username to log into FTP server.
* Password: Password for the user.

For use with "LKM SAP BW to SQL" these additional parameters must be
configured:

» JDBC driver class: com.sunopsis.jdbc.driver.file.FileDriver
* JDBC URL: jdbc:snps:dbfile?ENCODING=UTF8

The above URL is for SAP UNICODE systems. For non-UNICODE systems,
please see details on ENCODING parameter in Creating a File Data Server
of Connectivity and Knowledge Modules Guide for Oracle Data Integrator
Developer's Guide. The encoding chosen on this URL must match the code
page used by the SAP Application Server.

In this File data server create a Physical Schema representing the folder in the
File server to which the extraction file will be pushed. For use with FTP transfer,
see details below. For use with shared folder transfer and for more details, see
Transfer using a Shared Directory (recommended) of Application Adapters Guide
for Oracle Data Integrator:

- Data Schema: Path on the FTP server to upload or download extraction files
from the remote location. This path is used when uploading extraction files
from the SAP BW system into the FTP server. It is also used by a remote
agent to download the extraction files. Note that this path must use slashes
and must end with a slash character.
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*  Work Schema: Local path on the FTP server's machine. This path is
used by an agent installed on this machine to access the extraction files
without passing via the FTP server. This access method is used if the
FTP_TRANSFER_METHOD parameter of the LKM SAP BW to Oracle
(SQLLDR)/ LKM SAP BW to SQL is set to NONE. As Work Schema is an
OS file name, slashes/ backslashes should be used according to OS.

Path names given on Data and Work schemas are not necessarily the same:
the FTP service may provide access to a FTP directory named / sapfi | es
while the files can be stored locally in ¢c: \'i net pub\ ft proot\sapfiles.

Refer to File Transfer Considerations of Application Adapters Guide for Oracle
Data Integrator.

8. If the corresponding Logical Schema called Fil e Server for SAP ABAP does not
exist yet, create it. This Logical Schema name is fixed and must be mapped to the
Physical Schema created in the previous step.

3.2 Configuring the Target Data Server

This section describes how to setup an Oracle Data Server. Please use respective
settings when configuring a non-Oracle Target Data Server for use with LKM SAP BW
to SQL.

1. Connect to Topology Manager.

2. In the Physical Architecture tree view, expand the Technologies node and select
the Oracl e technology.

3. Right-click and select New Data Server.

4. Enter the data server Definition as shown below:

) CRACLE TARGET

Test Connection

Definition

EC lj Data Server
On Connect/Disconnect Marne: |0R.C\CLE_T.¢'.RGET
Propetties
2 Technology:
Dakasources
Version Instance [ dblink (Data Server): |><E
RECE Connection
Flexfields
User: (OD1_3AP_DEMO
Password:  |[eessssssssss

[] INDI Connection
Array Fetch Size: Batch Update Size:

5. Select the JDBC tab, and enter the JDBC connection information to your data
server as shown below:
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™) ORACLE TARGET

Test Connection

Definition

IDBC 0BT Driver:  |oracle jdbc, OracleDriver

0n ConneckfDisconneck jdbcioracle: thini@localhosk: 1521 XE
Properties IDBC Lrl:

Dakasources

Make sure to change the URL to match your Oracle instance configuration.
Click Test Connection to test the connection to this data server.

From the File menu, click Save.

Right-click the data server you created and select New Physical Schema.

In the Physical Schema windows that appears, select the ODI _SAP_DEMO for both
Schema and Work Schema.

If you already have a Work Schema for ODI defined for this data server, you can
use it instead of the CDI _SAP_DEMO Schema.

10. Go to the Context tab.
11. Click Add and enter in the Logical Schema field the value ODI _SAP_DEMD.

12. From the File menu, click Save.

3.3 Configuring the SAP Source Server

The following topics describe how to configure the SAP source server:

3.3.1 Configuring the Data Server

Except for the data server name, all the parameters that you provide while defining the
SAP Data server should be provided by the SAP Administrators. See Gathering SAP
Connection Informationfor more information about these parameters.

ORACLE

1.

In the Physical Architecture tree view, expand the Technologies node, select the
SAP ABAP technology.

Right-click and select New Data Server.

Enter the data server definition. Set the parameters for this data server as follows:
* Name: SAP_BW The name of the data server as it will appear in ODI.

* Host (Data Server): SAP BW System IP Address or Hostname.

e User: SAP User, as provided by the SAP Administrator.

» Password: This user's SAP Password. This password is case-sensitive.

Set the Flexfield values for this data server in the Flexfields tab:

* SAP Language: Code of the language used when logging in. For example EN
for English, DE for German.
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SAP Client Number: The three-digit number assigned to the self-contained
unit which is called Client in SAP. A Client can be a training, development,
testing or production client or represent different divisions in a large company.

SAP System Number: The two-digit number assigned to a SAP instance
which is also called Web Application Server or WAS.

SAP System ID: The three-character, unique identifier of a SAP system in a
landscape.

SAP Character Set: The character set is only required if your SAP system is
not a UNICODE system. For a complete list of character sets, see "Locale
Data" in the Oracle Database Globalization Support Guide. For example,
EE8I SOB8859P2 for Croatian Data. For UNICODE systems, use UTF8.

# Note:

This FlexField is only used with "LKM SAP BW to Oracle
(SQLLDR)". For use with "LKM SAP BW to SQL" please define
the character set using the ENCODING parameter in the file driver
URL, as described in Configuring the File Server for SAP ABAPfor
non-UNICODE SAP systems.

SAP BW Version: Enter the SAP BW Version as follows:

For SAP BW 7.0 and higher systems enter 700

For SAP BI 3.5 systems enter 350

SAP ERP Version & SAP ABAP Version: unused in SAP BW Connector.

From the File menu, click Save.

" Note:

The Test Connection button for validating SAP Connection definition is
not supported for this connection.

3.3.2 Configuring the Logical Schema

In the Physical Schema window, do not edit the Definition tab.

ORACLE

Select the Context tab, click Add and enter the Logical Schema name

LOG CAL_SAP_BW

B sap_Bw_Default

Definition
Context
Yersian Conkexk Loqical Schema
- Development OEICAL_SAP_EW
Privileges
Flexfields
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3. From the File menu, click Save.

ORACLE" 3-6



Creating a New Project

This chapter describes how to create a new Project for SAP.

In order to work with the data servers you have created, you must create a project and
import the appropriate knowledge modules for reverse-engineering the data structures

and integrating the data.

4.1 Creating a New Project

ORACLE

To create a new Project for SAP BW:

Connect to Designer.

In the Projects tree view click New Project.

In the Definition tab, enter SAP BW Denv for the Project name.
From the File menu, click Save to save your project.

Expand the SAP Denp Project, select the First Fol der node.
Rename this folder to SDE_BW Dat aTar get s.

Right-click the SAP Deno Proj ect in the Projects tree view.

Right-click and select Import Knowledge Modules.

© ©®© N o o p W DM PR

Select in the File import directory the directory containing your BW KMs. By
default, they are located in the . . /i npexp directory.

=
o

. Select the following KMs:

e |KM Oracle Incremental Update
LKM SAP BW to Oracle (SQLLDR)
LKM SAP BW to SQL
* RKM SAP BW
* RKM SAP ERP Connection Test

11. Click OK to perform the import.
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This chapter describes how to reverse-engineer the Oracle target and SAP source

data models.

This chapter includes the following sections:

5.1 Reverse-Engineering the Oracle Target

To reverse-engineer the Oracle data model:

1. Connect to Designer.

2. In the Models tree view, click New Model.

3. In the Definition tab, enter the model parameters as shown below:

[ Oracle Target

@ Reverse Enginesr %

Definition
Reverse Engineer
Control
Journalizing
Journalized Tables
Services

Matkers

Memo

Version

Privileges
Flesxfields

Generate and deploy

Model
Mame: ZIZIr'-an:IEe Target
Code: ORACLE_TARGET
Technology: | Oracle

Logical Schema: |ODI_SAP_DEMO

Action Group: | ZGeneric Ackion =

Default Folder: |

Descripkion:

4. Inthe Reverse Engineer tab, select the Global context.

ORACLE
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Oracle Targek
f@ Reverse Enginesr | %

Definition

Heverse Engineer
Selective Reverse-Engineering
Conkral

Journalizing
Journalized Tables
Services

Markers

Memao

Wersion

Privileges

Flexfields

Chapter 5

Reverse-Engineering the SAP BW Source Datastores

Generate and deploy

(#) Standard] () Custamized

Conkext: | Global

Logical Agent: ILu:u:aI (Mo Agenk)

Types of objects to reverse-engineer

Table Yigw Queue [ | Syster Table [ ] Table Alias

[] Synonym

o

Mask:

Characters to Remove From Table Alias: ‘W

Table Alias maximum length: ‘35

5. Click Reverse Engineer, then from the File menu, click Save.

6. The W PURCH DS, W ACCNT_VENDR DS, W GL_ACCOUNT_HI ER_DS, W VENDR _BAL_DS,
W VENDER_CUBE_OBJ_DS, W OPENHUB_SALES DS, W DELTA DS datastore appear in
your Oracle_Target model, as shown below.

#)-1; 5 ORDERSO3
[+ ORDERSO3 TARGET

+ # Usedin
T Diagrams
w0 ot Hierarchy
@ [T W_ACCNT_VENDR_DS
+- [ 3] 'w_DELTA_DS
+ [ w_GED_DS
# [ W_GL_ACCOUNT_HIER_DS
+ [ 7] W_OPENHUB_SALES_DS
& [T W_PURCH_DS
+ [ W_VENDER_CUBE_OB]_DS
[ w_VENDR_BAL DS

+ Hidden Datastores

[+ LA 54l FASFORCF R

5.2 Reverse-Engineering the SAP BW Source Datastores

To reverse-engineer the SAP BW Source data targets you need to perform the

following tasks:

1. Creating the Data Model

2. Validating the SAP Connection

3. Starting the Reverse-Engineering Process

This section also includes the following topics:

ORACLE
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5.2.1 Creating the Data Model

In the Models tree view, click New Model.

In the Definition tab, select SAP ABAP technology and the Logical Schema
previously created (in our example it is the LOG CAL_SAP_BW Logi cal Schena ).

In the Reverse Engineer tab:
a. Select Cust om zed option.
b. Selectthe d obal context.

c. Select the RKM SAP Connection Test you have imported in the SAP BW Denp
project.

5.2.2 Validating the SAP Connection

ORACLE

In the Models tree view, open the SAP BW Sour ce Model.

Click Reverse Engineer and confirm the start of the reverse-engineering process.
This process runs two tests:

» Establish a test connection to the SAP BW system and
e Validate the proper setup of SAP JCo by displaying the About dialog.

In a few seconds, you should see the SAP JCo-About dialog as shown here:
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SAP Java Connector (JCo) |:||i[z|

THE BEST-RUN E-BUSINESSES RUN SAP W

SAP Java Connector (JCo)
Copyright (c) 2000-2007 SAP AG. All rights reserved.
Java Runtime

Operating System: Windows XP 5.1 for x86
Java VM: 1.6.0_14 Sun Microsystems Inc.

Java Codepage: Cp1252

Versions

JCo AP 3.0.2 (2008-03-29)

JCo middleware name: eI

JCo middleware: 11

JCo middleware native: GRERCE

Paths

JCo classes: CAProgram%20Files\Oracleloracledi_10135Noracledivdriversi\sapjco3 jar

JCo library: CAProgram Files\Oracle\oracledi_101351oracleditdriversisapjco3.dll

Please verify the JCo version number (see System Requirements and
Certificationfor more details) and verify that a path for the JCo Library is given
(. dI'l for Windows). If this is not the case or you see any error message in this
about dialog, please review the SAP JCo installation, as described in your SAP
JCo package, and run this test again.

< Note:

Closing the JCo-About-Dialog will also close ODI.

4. Once you have validated SAP JCo installation, open ODI Operator.
5. In the Operator, expand the Reverse-Engineering session down to the task level.

6. Verify whether the task "Test SAP Connection" has been executed successfully. If
not, view the task details to identify the connection problem. The output of this task
must contain Successful Iy connected to SAP System If not, the connection test
has failed and the connection problem must be analyzed before you continue.

Do not continue until you have successfully validated the SAP connection!
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< Note:

If you want to validate the SAP connectivity independent of ODI, please see
SAP Stand-Alone Connection Test.

5.2.3 Starting the Reverse-Engineering Process

To start the reverse-engineering process of the SAP BW datastores:

1. Import TR.

" Note:

See also, Installing SAP Transport Request (TR) in the Application
Adapters Guide for Oracle Data Integrator.

2. In the Models tree view, open the SAP BW Sour ce Model.
3. Inthe Reverse Engineer tab:
a. Select the d obal context.
b. Select the Customi zed option.
c. Select the RKM SAP BWyou have imported in the SAP BW Denp project.
d. Setthe USE QU KMoption to Yes.
e. Set UPLOAD ABAP_CODE and UPLOAD ABAP_BASE to False.

Caution:

Make sure to provide the correct value for the
SAP_TRANSPORT_LAYER _NAME opt i on.

f. Set other parameters according to your SAP configuration. See the Application
Adapters Guide for Oracle Data Integrator for more information on the RKM
options.

4. From the File menu, click Save to save your changes.
5. Click Reverse Engineer to start the reverse-engineering process.
6. Click OK.
The Sessions Started Dialog is displayed.
7. Click OK.

5.2.4 Using the SAP Metadata Browser

As you have set the USE_GUI option to Yes, the RKM displays in the SAP BW
Metadata Browser the SAP objects organized in the tree view as shown below.
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< Note:

In case that the below dialog does not show up, see ODI Operator and ODI
Logs for details.

Refer to Log Files in Application Adapters Guide for Oracle Data Integrator
for more details.

| £ SAP BWY Meta Data Broweser EI@
Search
Marme:
Deszcription:
Data Target: % InfoCube " Infoobject ODSDS0 " OpenHub
Lookup Search
L) SA&P By Metadata

- (2 Infosress
[ [ InfoOkjects
B 1 ODSDSO
B 1] OpenHub

Cancel Reverse
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The SAP BW Data targets are organized into a tree view. Only the SAP BW Data
targets available in the SAP BW system are displayed. By expanding the tree view,
you can see Info Cubes, Info Objects, ODS/DSO, Open Hub, and select those that you
want to reverse-engineer.

Note that only the data targets selected in the tree view are reverse-engineered.

[£:] S0P B beta Data Browser

oo e

" OpenHuh

Search
Marme:
Description:
Data Target: @ InfoCube " InfoChject (" ODSDS0
Lookup Search
_| QCa, Crozs-Application Components
_| DCREM Customer Relationship Management

OFIN_REP_SIMPL_1_EHP3

m

= J InfaCube
- [0 oF1ap_cs1
- [ oFlap_R20
[ OFI&P_RS0
- [ OFlaP_R51
- [ OF18P_mz0
- [ OF18P_MSD
[0 OF1ap_ms1
- [ OFlaP_c30
- [0 OF1ap_R30
- [ OF1aP_m30
=[] oFlap_c20
: |_LT_| Ditvenszions

et A ariam ~ea

22 OFIN_REP_SIMPL_1_FHP3_COOMOPA,
£ 5] OFIN_REP_SIMPL_1_EHP3_COPC
| OFIN_REP_SIMPL_1_EHP3_FIGL

| OFIN_REP_SIMPL_1_EHPS_COOMCCA,
- £ OFIN_REP_SIMPL_1_EHP3_FIAP

= _| OFRAC Financial Management & Controlling
21 OPSM Public Sector Management
29000 Cortroling
#10F1 Finsncial Accourting

Reporting Financialz (EhP3)

Owerhiead Cost Orders
Product Cost Contralling
General Ledger Accounting
Cost Center Accounting
Accounts Payable Accounting

Check Register: Line
Yendor Balances (Dir
Check Regizter (Dire
Check Regizter: Line
“endor Balances
Check Register
Check Register: Line
Yendors: Line tem (
Yendors: Line tem (
Wendors: Line tems
Yendor Balances (Rep

|_H__| Kevy Figures

1 [T e PRI T |

ORACLE
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5.2.4.2 The Search Panel

The Search option group allows you search specific objects in the browser, based on:
* Info Cube Name

e Info Object Name

+ ODS/DSO

e Open Hub

For the example project for Info Cube, the data target OFIAP_C20 is used:

1. Enter OFI AP_C20 in the Name field.
2. Select the InfoCube data target.

3. Click Search to find the object to reverse-engineer. The results are highlighted in
the tree view.

4. Click Reverse.

5. Oracle Data Integrator starts the reverse-engineering process on the selected data
target. The reverse-engineered data targets appear under the Model.

6. Perform steps 1 to 5 to reverse-engineer the following objects:
a. InfoCube 0SD Q04

InfoObject 0SOLD_TO

c. InfoObject OCREDI TOR

d. InfoObject 0GL_ACCOUNT

e. ODS/DSO 0BBP_PO

f.  Open Hub destination ZOHD_SALE (/ Bl ¢/ OHZOHD_SALE)

3

5.2.5 Reverse-Engineering Without GUI

If you want to perform a reverse-engineering without using the SAP BW Metadata
Browser, you set the corresponding parameters in the SAP BW KM . For example, for
Info Cube, enter the following parameters in the SAP BW KM options:

* USE_GUI: No
* INFOCUBE_NAME : OFI AP_C20

With this configuration, the Info Cube data target will be reverse-engineered without
displaying the SAP BW Metadata Browser.

By using the appropriate KM options, you can also select a filter for the reversed data
targets based on for example an Info object, or a ODS/DSO, or an Open Hub table.

Refer to the Application Adapters Guide for Oracle Data Integrator for more
information on the RKM options.
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< Note:

It is not possible to view the data in the SAP BW data targets from Oracle
Data Integrator.

What happens when you reverse-engineer SAP BW data targets?

First, Oracle Data Integrator uploads ABAP code in the SAP BW system allowing

for retrieving the SAP BW data targets metadata. This RFC is uploaded only if the
UPLQAD _ABAP_CCDE and UPLOAD _ABAP_BASE options are selected (this option is typically
activated only once). The ABAP programs are generated in the SAP function group
given in the SAP_FUNCTI ON_GROUP_QODI _DEV and SAP_FUNCTI ON_GROUP_CDI _PRCD RKM
options.

Once this code is set up on SAP BW, Oracle Data Integrator is able to retrieve the
SAP BW metadata and to display it in the SAP BW Metadata Browser. Selected
metadata is then reverse-engineered from SAP BW into the Oracle Data Integrator
repository. The repository only contains the description of the SAP BW metadata, and
no data at all.

In addition to the data targets definitions organized and enriched with user-friendly
information, the keys definitions are also retrieved. The model appearing in Oracle
Data Integrator shows all the information required for performing integration tasks on
the SAP BW Model.
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Creating and Running the Mapping

This chapter describes how to create and run the mapping.
This chapter includes the following sections:

6.1 Creating the Mapping

Now that the ODI source and target data models have been created, it is possible to
create the ODI mappings to extract data from the following SAP BW data targets:

e The Info Cube OFI AP_C20 data target to W VENDR BAL_DS Oracle table.
*  The Info Object 0CREDI TOR data target to W ACCNT_VENDR DS Oracle table.

e The Hierarchy data from Info Object 0GL_ACCOUNT to W GL_ACCOUNT_Hl ER DS
Oracle table.

* The Interval Hierarchy data from InfoObject 0GL_ACCOUNT to
TARGET_| NTERVAL_HI ERARCHY Oracle table.

« The ODS/DSO 0BBP_POdata target to W PURCH DS Oracle table.

e The Info Cube OFI AP_C20 and Info Object OCREDI TCR data targets join to
W VENDER _CUBE_OBJ_DS Oracle table.

» The InfoCube and Navigation Attribute data from | C 0SD C04 / 10 0SOLD TOto
TARGET_NAVI GATI ONAL_ATTRI BUTES Oracle table.

e The Open Hub destination ZOHD SALE (/BI C/ OHZOHD SALE) to
W OPENHUB_SALES DS Oracle table.

e Delta Extraction can be done on any above said data targets except Info Object.
How to perform delta extraction is described in Creating a Package for Delta
Extraction .

To create the mapping, perform the following steps:

6.1.1 Info Cube Extraction

This section describes how to create a mapping in ODI in order to load data from
the SAP BW source model representing the InfoCube OFI AP_C20 data target to the
W VENDR_BAL_DS Oracle target model.

6.1.1.1 Create the Mapping

To create the mapping:

1. Open Designer.

2. In the Projects tree view, expand the SAP BW Demo Project.
3. Expand the SAP_BW Dat aTar get s folder.

4. Select the Mappings node.
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Right-click and select New Mapping.

In the Mapping Definition tab, enter the mapping name:
| nf oCube_SAP_BW Vendor Bal . W VENDR_BAL_DS.

From the File menu, click Save to save your mapping.

6.1.1.2 Define the Source and Target Datastores

To define the source and target datastores:

1. Inthe Models tree view, select the W VENDR BAL DS datastore from the
Oracl e_Target Model.

2. Drag this datastore into the Target Datastore area of the Logical diagram (right
area of the Logical diagram).

3. Inthe Models tree view, select the OFI AP_C20 Vendor Bal ances datastore from
the SAP BW Sour ce model.

4. Drag this datastore into the Sources area of the Logical diagram (left area of the
Logical diagram).

6.1.1.3 Create the Mappings

To create the mappings of the target datastore:

1.
2.

Select the 0COVP_CQODE attribute from the target datastore.

Drag the | OPK_OFI AP_C201_0COVP_CCDE_PK_COWP_CCDE attribute from the
OFI AP_C20 Vendor Bal ances source datastore onto the COMP_CODE attribute
of the target datastore.

Make sure that the Execute on Hint is set to Source. The mapping should look as
shown below:

COMP_CODE - Properties

Q, Find

=] Target

Expression:

Execute an Hink:

4.

ORACLE

OFTAP_C20.I0PK_OFIAP C201_OCOMP_CODE_PK_COMP_CODE

| Source - |:

Fixed Execution Location: | - |:

Technical Descripkion: | |:

Repeat this operation to perform the following simple mappings:

«  WVENDR BAL_DS. OCREDI TCR =
OFI AP_C20. | OPK_OFI AP_C202_OCREDI TOR_PK_VENDOR

« W VENDR BAL_DS. ORC ACCOUNT =
OFI AP_C20. | OPK_OFI AP_C202_ORC_ACCOUNT_PK_GL_ACCOUNT

« W VENDR BAL_DS. TOTAL DEBI T PCSTING = OFI AP_C20. KF_ODEBI T
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«  WVENDR BAL_DS. TOTAL CREDI T PCSTING - OFI AP_C20. KF_ODEBI T
«  WVENDR BAL_DS. CUMULATI VE BALANCE - OFI AP_C20. KF_OBALANCE

6.1.1.4 Define the Mapping Flow

To define the mapping flow:

1. Select the Physical diagram. The Flow diagram looks as shown below:

T TARGET_GROUP
3¢ SOURCE_GROUP (&  ODI_SAP_DEMO_UNIT
+ LOGICAL_SAP_BW_LI
B |
= — ——®
AFIAP_C2C W_VENDR_BAL_DS
AFIAP_C20

2. In the target group, select the access point for the source group that contains
Info Cube OFI AP_C20 data target. This source group represents the source dataset
made up of SAP BWdata target.

3. Inthe Property panel, under Loading Knowledge Module, select LKM SAP BWt o
Oracle (SQLLDR) or LKM SAP BWto SQ. from the Loading Knowledge Module
drop-down list.

4. In the target group, select the target Oracle database, which is also used as the
staging area for this mapping.

5. In the Property panel, under Integration Knowledge Module, select | KM Oracl e
I ncremental Updat e from the Integration Knowledge Module drop-down list.

6. Set the IKM options as follows:
a. Select No for the FLOW_CONTROL option.
b. Leave other options as they are.

7. From the File menu, click Save and close your mapping.

6.1.2 Info Object Extraction

This section describes how to create a mapping in ODI in order to load data from
a SAP BWsource model representing the Info Object 0CREDI TOR data target to the
W ACCNT_VENDR_DS Oracle target model.

6.1.2.1 Create the Mapping

1. Open Designer.
2. Inthe Projects tree view, expand the SAP BW Denp Project.
3. Expand the SAP_BW Dat aTar get s folder.
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Select the Mappings node.
Right-click and select New Mapping.

In the Mapping Definition tab, enter the mapping name:
I nf 0Obj ect _SAP_BW Vendor Acc. W ACCNT_VENDR DS.

From the File menu, click Save to save your mapping.

6.1.2.2 Define the Source and Target Datastores

To define the source and target datastores:

1.

In the Models tree view, select the W ACCNT_VENDR DS datastore from the
Oracl e_Target Model.

Drag this datastore into the Target Datastore area of the Logical diagram (right
area of the Logical diagram).

In the Models tree view, select the Info Object's main table 0CREDI TOR Vendor
datastore from the SAP BWSource model.

Drag this datastore into the Sources area of the Logical diagram (left area of the
Logical diagram).

Perform the same operation for the Info Object text table TXT_OCREDI TOR Text s:
Char. Vendor datastore from the SAP BWSource model.

6.1.2.3 Define Joins between Info Object's Main table and Text Table

ORACLE

To create joins between the source datastores of Info Object's main table and text
table in the mapping:

1.

In the Logical diagram when you drag the Info Object's text table TXT_OCREDI TOR
Texts: Char. Vendor the join will be automatically created on attribute vendor from
the OCREDI TOR Vendor Info object's main table datastore and the Vendor attribute
of Info Object's text table TXT_OCREDI TOR Texts: Char. Vendor. This defines the
first join on the vendor Key identifier, as shown below:
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5] OCREDITOR |
W)@~ VENDOR =

PCOMPANY

PHONE

PLANT

POBOX

POBOX_LOC

POSTAL_CD

POSTCD_BOX i TXT_OCREDITOR

POSTCD_GIS # B= VENDOR
PRECISID i THTMD

REGION i
SORTL

SRCID

STREET

TAX_NUMB

TAX_NUMB2

TRZONE

UNLD_PT_WE

NAME3

ACCNT GRPV

h
=
h

2. In the Properties panel, select Joi n Order and make sure that the Execute on
Hint option is set to Source as shown below:

J2IM - Properties
Q, Find

[= Condition

OCPEDITOR. VENDOR = TXT OCREDITOR.VEHDOR
Join Condition:

Cross Matural
OCREDITOR(OCREDITOR) E [] T¥T_OCREDITOR{TXT_DCREDL...
Jain Type:
(4 Innet Join

all rows paired by the join condition bebween OCREDITOR(OCREDITOR) and TxT_OCREDITOR{TXT_OCREDITCOR)

Technical Description: | |

Generate AMSI Syntax: [

Join Order: User Defined: |10 |
Execute on Hint: an hint v|
General
Connector Points Staging

3. Make sure that table number of main table OCREDI TCR is smaller than that of text
table TXT_OCREDI TOR. In 1:n relationships the parent table has to be the first in a
join.
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4. Change join type to left outer join (All rows from 0CREDI TOR and matching ones
from TXT_OCREDI TOR.

6.1.2.4 Create the Mappings

To create the mappings of the target datastore:

1. Select the VENDOR attribute from the target datastore.

2. Drag the VENDCR attribute from the OCREDI TOR source data target onto the

VENDOR attribute of the target datastore.

3. Make sure that the Execute on Hint option is set to Source. The mapping should
look as shown below:

YEMDOR - Properies

Q, Find 2
=] Targekt
OCREDITOR. VENDOE
Expressian:
Execute on Hink: |5|:|ur|:e
Fixed Execution Location: |

4. Repeat this operation to perform the following simple mappings:

W ACCNT_VENDR DS. PCOVPANY = OCREDI TOR. PCOVPANY
W ACCNT_VENDR DS. PHONE = OCREDI TOR PHONE

W ACCNT_VENDR DS. PLANT = OCREDI TOR PLANT

W ACCNT VENDR DS. STREET = OCREDI TOR STREET

W ACCNT_VENDR DS. MED DESC = TXT_OCREDI TCR. TXTMD

6.1.2.5 Define the Mapping Flow

To define the mapping flow:

1. Select the Physical diagram. The Flow diagram looks as shown below:

ORACLE
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T SOURCE_GROUP
<% LOGICAL_SAP_BW_UNIT
L TARGET_GROUP
(]
— (= ODI_SAP_DEMO_UNIT

TXT_OCREDITOR

L (O3 L :_ E

= JOIN JOIN_AP W_ACCHNT_VEMDR_DS

(58

ACREDITOR

2. In the target group, select the access point for the source group that contains both
the Info Object's main table 0CREDI TOR and text table TXT_OCREDI TOR. This source
group represents the source dataset made up of Info Object's main table & text
table joined SAP BWdata targets.

3. Inthe Property panel, under Loading Knowledge Module, select LKM SAP BWt o
Oracle (SQLLDR) or LKM SAP BWto SQ. from the Loading Knowledge Module
drop-down list.

4. In the target group, select the target Oracle database, which is also used as the
staging area for this mapping.

5. Inthe Property panel, under the Integration Knowledge Module, select | KM Or acl e
I ncremental Updat e from the Integration Knowledge Module drop-down list.

6. Setthe IKM options as follows:

a. Select No for the FLOW_CONTROL option.
b. Leave other options as they are.
7. From the File menu, click Save and close your mapping.

6.1.3 Info Object Hierarchy Extraction

This section describes how to create a mapping in ODI in order to load data from a
SAP BW source model representing the hierarchy data for Info Object 0G._ACCOUNT
data target to the W GL_ACCOUNT_H ER DS Oracle target model.

6.1.3.1 Create the Mapping

ORACLE
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Open Designer.

In the Projects tree view, expand the SAP BW Denp Project.
Expand the SAP_BW Dat aTar get s folder.

Select the Mappings node.

Right-click and select New Mapping.

In the Mapping Definition tab, enter the mapping name:
I nf oChj ect _SAP_BW G Account. W GL_ACCOUNT_HI ER_DsS.
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7. From the File menu, click Save to save your mapping.

6.1.3.2 Define the Source and Target Datastores

To define the source and target datastores:

1. Inthe Models tree view, select the W GL_ACCOUNT_DS datastore from the
Oracl e_Target Model.

2. Drag this datastore into the target area of the Logical diagram (right area of the
Logical diagram).

3. In the Models tree view, select the Info Object's hierarchy table H ER_ 0G._ACCOUNT
datastore from the SAP BWSource model.

4. Drag this datastore into the sources area of the Logical diagram (left area of the
Logical diagram).

5. Add the following filter condition on the RSHIENM source attribute:
H ER_O0GL_ACCOUNT. RSHH ENM = ' ACI 1

Please note that ACI 1 is the name of a hierarchy defined for 0GL_ACCOUNT. A list
of defined hierarchies is available under Description section of the Definition tab
when opening the hierarchy data store.

6. After adding the filter condition the Sources diagram should look as shown below:

] HER_0GL_ACCOUNT

B RSHENM =

@=  HIED

@=  NODED
IOBJNM . a2 e
NODEMAME ——0 f e
TLEVEL
LINK
PARENTID
CHILDID
NEXTID

6.1.3.3 Create the Mappings

ORACLE

To create the mappings of the target datastore:
1. Select the H ER_NAME attribute from the target datastore.

2. Drag the RSH ENMattribute from the H ER_0G._ACCOUNT source data target onto the
HIER_NAME attribute of the target datastore.

3. Make sure that the Execute on Hint option is set to Source. The mapping should
look as shown below:
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HIER_MAME - Properties

Q, Find

5l

=] Target

Expressian:

Execute on Hink:

Civemd Cuvmmikimem | mm ki |

HIFR. 0GL ACCOUHT . RSHTEHM

| Source

Repeat this operation to perform the following simple mappings:

«  WG._ACCOUNT_HI ER DS. NODEI D = H ER_0GL_ACCOUNT. NCDEI D

«  WGL_ACCOUNT _H ER DS. | NFOOBJECT _NAME = H ER_0GL_ACCOUNT. | OBINM
e WG, _ACOOUNT_H ER DS. NODENAME = HI ER_0GL_ACCOUNT. NODENAVE

e WGL_ACCOUNT Hl ER DS. TLEVEL = HI ER 0GL_ACCOUNT. TLEVEL

¢ WGL_ACCOUNT_Hl ER DS. PARENTI D = H ER_0GL_ACCOUNT. PARENTI D

¢ WGL_ACCOUNT H ER DS.CHI LDID = H ER_0GL_ACCOUNT. CH LDI D

e WGL_ACOOUNT _H ER DS. NEXTI D = HI ER_0GL_ACCOUNT. NEXTI D

6.1.3.4 Define the Mapping Flow

ORACLE

To define the mapping flow:

Select the Physical diagram. The Flow diagram looks as shown below:

Y SOURCE_GROUP " TARGET_GROUP
¥ LOGICAL_SAP_BW_UI ® ODI_SAP_DEMO_UNIT
= = [
I 3
HIER_0GL _ACCOUNT HIER_0GL_ W_GL_ACCOUNT_HER_DS

In the target group, select the access point for the source group that contains both
the Info Object's main table 0CREDI TOR and text table TXT_OCREDI TOR. This source
group represents the source dataset made up of Info Object's main table & text
table joined SAP BWdata targets.

In the Property panel, under Loading Knowledge Module, select LKM SAP BWt o
Oracle (SQLLDR) or LKM SAP BWto SQ. from the Loading Knowledge Module
drop-down list.

In the target group, select the target Oracle database, which is also used as the
staging area for this mapping.

In the Property panel, under Integration Knowledge Module, select | KM Or acl e
I ncrenental Updat e from the Integration Knowledge Module drop-down list.
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Set the IKM options as follows:
a. Select No for the FLOW_CONTROL option.
b. Leave other options as they are.

From the File menu, click Save and close your mapping.

6.1.4 Info Object Interval Hierarchy Extraction

This section describes how to extract data from InfoObject and InfoObject hierarchy
table containing an interval hierarchy. The data is extracted from InfoObject
0G._ACCOUNT and InfoObject hierarchy table H ER_0GL_ACCOUNT.

6.1.4.1 Create the Mapping

7.

e a » 0 d PR

Open Designer.

In the Projects tree view, expand the SAP BW Deno Project.
Expand the SAP_BW Dat aTar get s folder.

Select the Mappings node.

Right-click and select New Mapping.

In the Mapping Definition tab, enter the mapping name:
I nf 0Obj ect _| nf oCbj ect H erarchy_j oi n. 0GL_ACCOUNT.

From the File menu, click Save to save your mapping.

6.1.4.2 Define the Source and Target Datastores

To define the source and target datastores:

1.

In the Models tree view, select the TARGET | NTERVAL _HI ERARCHY datastore from
the Oracl e_Target Mdel WSD DELI VERY_CUBE_SOLDTO.

Drag this datastore into the target area of the Logical diagram (right area of the
Logical diagram).

In the Models tree view, select the InfoObject 0G._ACCOUNT from the SAP BW
source model.

Drag this datastore into the sources area of the Logical diagram (left area of the
Logical diagram).

Perform the same operation for the InfoObject hierarchy table H ER 0G._ACCOUNT
datastore from the SAP BW Source model.

6.1.4.3 Define Joins between Sources (Info Object Main table and InfoObject

Hierarchy Table)

ORACLE

The join between InfoObject and InfoObject Hierarchy table may automatically be
added by ODI. - There may be situations when more than one join shows up. E.g.
when the same InfoObject is referenced more than once in different characteristics.
Such unwanted extra joins have to be removed.

Apply source-side Filters on RSHIENM and VERSION:
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FILTER - Properties
Q Find
[= Condition

]'I]IH_I]II._RCCI]UHT.RS]‘I]EHI-I = 'BW IFC'
Filter Condition:

Technical Description: | |

Execute on Hint: [Sn:-urn:e ']

FILTER1 - Properies
Q. Find

= Condition

HIER 0GL. ACCOUHT .VERSTOW = 'A!
Filker Condition:

Technical Description; | |

Execute an Hink: [Su:uurce 'l

Add joins: all joins must be executed on staging area. Not on source.

The join expression looks like this:

@ om-moswes [
Q, Find
Condition {GL_ACCOUNT.CHRT RCCTS || GL_ACCOUNT,GL_ACCOUNT) =HIER OGL_RCCOUNT.HODEWAME
General Join Condition: HIER_0GL_ACCOUNT.THTERVL='' (7 (GL_ACCOUNT.CHRT RCCTS || GL_RCCOUNT.GL_RCCOUNT)
Connector Points JUTIETY WIER_OGL_RCCOUNT.LERFFROM /1) HIER_0GL_RCCOUNT.LEAFTO /' HIER OGL_RCCOUNT . TNTERVL='}'
Cross Matursl
GL_ACCOUNT(GL_ACCOUNT) [ [ HIER_DGL_ACCOUNT{HIER_O...
o Tvpe: Left Outer loin
All rows of GL_ACCOUNT(GL_ACCOUNT) including the rows unpaired with HIER_OGL_ACCOUNT{HIER _0GL_ACCOUNT) rows
Technical Description: I].[Page of Hierarchy to] AND [HIER _0GL_ACCOUNT Hierarchy: InfoObject GiL Account (HIER_0GL_ACCOUNT)].[Flag: Node is htavd]='x'|
Generabe ANST Syntax: [+
Jain Order: [ User Defined:
The final join and filter setup should look like this:
ORACLE
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@~  RSHENM
B~ HED
@~  NODED

10BJMM
© NODENAME
TLEVEL
LINK
PARENTID
CHILDID
MNEXTID

6.1.4.4 Create the Mappings
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(T o o T o
FILTER FILTER1
. L ] L ]
o
= GL_ACCOUNT ) O
@=  CHRT ACCTS = * on
@= "1 GL ACCOUNT =
BAL_FLAG =
GLACCEXT
INCST_FLAG
LOGSYS
SEM_POSIT

SOURSYSTEM

To create the mappings of the target datastore:

1. Drag the NODEI D attribute from the HIER_OGL_ACCOUNT source data target onto
the NODEID attribute of the TARGET_INTERVAL_HIERARCHY target datastore.

2. Make sure that the Execute on Hint option is set to Source. The mapping should

look as shown below:

MODEID - Properties

Q, Find
=] Target
HIFR_0GL_ACCOUNT . HODEID
Expression:
Execute on Hint: | Source v|
_— e e |
3. Repeat this operation to perform the following simple mappings:
*  TARGET_I NTERVAL_H ERARCHY. RSH ENM = H ER_OG._ACCOUNT. RSHI ENM
«  TARGET_INTERVAL_HIERARCHY.PARENTI D = H ER_OG._ACCOUNT. PARENTI D
*  TARGET_INTERVAL_HIERARCHY.I NTERVL = HI ER_OGL_ACCOUNT. | NTERVAL
*  TARGET_INTERVAL_HIERARCHY.LEAFFROM = H ER_OG._ACCOUNT. LEAFFROM
*  TARGET_INTERVAL_HIERARCHY.LEAFTO = H ER_OGL_ACCOUNT. LEAFTO
*  TARGET_INTERVAL_HIERARCHY.VERSI ON = H ER_OG._ACCOUNT. VERSI ON
*  TARGET_INTERVAL_HIERARCHY.CHRT_ACCTS = OGL_ACCOUNT. CHRT_ACCTS
ORACLE
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*  TARGET_INTERVAL_HIERARCHY.G._ACCOUNT = OGL_ACCOUNT. G._ACCOUNT
*  TARGET_INTERVAL_HIERARCHY.BAL_FLAG = OGL_ACCOUNT. BAL_FLAG
*  TARGET_INTERVAL_HIERARCHY.GLACCEXT = OGL_ACCOUNT. GLACCEXT
*  TARGET_INTERVAL_HIERARCHY.I NCST_FLAG = OGL_ACCOUNT. | NCST_FLAG

6.1.4.5 Define the Mapping Flow

To define the mapping flow:

1.

Select the Physical diagram. The Flow diagram looks as shown below:

'L SOURCE_GROUP
= LOGICAL_SAP_BW_UNIT 4] TARGET_GROUP
ODI_SAP_DEMO_UNIT
i) O —
. > v > v C .
HIER_0GL_ACCOUNT_1 FILTER_1 FILTER1 _1 o ]

>
TARGET_INTERVAL _HERARCHY _

E .
4 JOR_AP

5]

GL_ACCOUNT

In the target group, select the access point for the ODI Source Group.

In the Property panel, under Loading Knowledge Module, verify that LKM SAP BW
to Oracle (SQLLDR) or LKM SAP BWto SQ has been set.

4. In the target group, select the target Oracle datastore, which is also used as the
staging area for this mapping.
5. In the Property panel, under Integration Knowledge Module, verify that IKM SQL
Control Append has been set.
6. [Execute the Mapping. Verify that data got populated into the target datastore.
6.1.5 ODS/DSO Extraction

This section describes how to create a mapping in ODI in order to load data from
a SAP BW source model representing the ODS/ DSO 0BBP_PO data target to the
W PURCH_DS Oracle target model.

6.1.5.1 Create the Mapping

ORACLE
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Open Designer.

In the Projects tree view, expand the SAP BW Denp Project.
Expand the SAP_BW Dat aTar get s folder.

Select the Mappings node.

Right-click and select New Mapping.

In the Mapping Definition tab, enter the mapping name:
ODS_SAP_BW Pur chOr dl . W PURCH_DS.

From the File menu, click Save to save your mapping.
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6.1.5.2 Define the Source and Target Datastores

To define the source and target datastores:

1. Inthe Models tree view, select the W PURCH DS datastore from the Oracl e_Tar get
Model.
2. Drag this datastore into the targets area of the Logical diagram (right area of the
Logical diagram).
3. Inthe Models tree view, select the 0BBP_PO Purchase Order - Single Docunents
datastore from the SAP BWSource model.
4. Drag this datastore into the sources area of the Logical diagram (left area of the
Logical diagram).
6.1.5.3 Create the Mappings
To create the mappings of the target datastore:
1. Select the PO _GQUI DE attribute from the target datastore.
2. Drag the BBP_POGUI D attribute from the 0BBP_PO Purchase Order - Single
Docunent s source data target onto the PO_GUIDE attribute of the target datastore.
3. Make sure that the Execute on Hint option is set to Source. The mapping should
look as shown below:
POGUID - Properties
Q, Find 2
=] Target
OBEEF _PO.EEP_POGUID
Expression:
Execute on Hink: |Su:uuru:e "’|
Fixed Execution Location: | v|
Tarhrical Pacmvinkinms | |
4. Repeat this operation to perform the following simple mappings:

ORACLE

«  WPURCH_DS. ORDER | TEM GUI D = 0BBP_PQ. BBP_PO TGU
« WPURCH_DS. ACC_ASS GUI D = 0BBP_PQ BBP_ACGUI D

«  WPURCH DS. GU DE_CONTRCT = 0BBP_PO. BBP_CTGUI D

«  WPURCH_DS. ORDER QUANT = 0BBP_PQ BBP_ASPQOU

«  WPURCH DS. NET_PRI CE = 0BBP_PQ BBP_NETPRC

«  WPURCH DS. PRICE_UNI T = OBBP_PQ. BBP_PRCUNT

«  WPURCH_DS. NO_OF PURCH ODR = 0BBP_PQ. BBP_POCT
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6.1.5.4 Define the Mapping Flow

To define the mapping flow:

1.

7.

Select the Physical diagram. The Flow diagram looks as shown below:

7% SOURCE_GROLP s TARGET_GROUP
= LOGICAL_SAP_BW_LIt (®) ODI_SAP_DEMO_UNIT
i - I
—
ABEP_FO ABBP_PO_ W_PURCH_DS_

In the target group, select the access point for the source group that contains
ODS/ DSO 0BBP_PO data targets. This source group represents the source dataset
made up of SAP BWdata target.

In the Property panel, under Loading Knowledge Module, select LKM SAP BWt o
Oracle (SQLLDR) or LKM SAP BWto SQL from the Loading Knowledge Module
drop-down list.

In the target group, select the target Oracle database, which is also used as the
staging area for this mapping.

In the Property panel, under Integration Knowledge Module, select | KM Or acl e
I ncremental Updat e from the Integration Knowledge Module drop-down list.

Set the IKM options as follows:
a. Select No for the FLOW_CONTROL option.
b. Leave other options as they are.

From the File menu, click Save and close your mapping.

6.1.6 Info Cube & Related Info Object Extraction

This section describes how to create a mapping in ODI in order to load data from
a SAP BW source model representing the Info Cube OFI AP_C20 and Info Object
O0CREDI TOR data targets join to the W VENDER _CUBE_OBJ_DS Oracle target model.

6.1.6.1 Create the Mapping

ORACLE

o g p W NP

Open Designer.

In the Projects tree view, expand the SAP BW Denp Project.
Expand the SAP_BW Dat aTar get s folder.

Select the Mappings node.

Right-click and select New Mapping.

In the Mapping Definition tab, enter the mapping name:
I nf oCube_| nf oObj ect _j oi n. W VENDER CUBE_OBJ_DS.
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7. From the File menu, click Save to save your mapping.

6.1.6.2 Define the Source and Target Datastores

To define the source and target datastores:

1. Inthe Models tree view, select the W VENDER CUBE_OBJ_DS datastore from the

Oracl e_Target Model.

2. Drag this datastore into the target area of the Logical diagram (right area of the

Logical diagram).

3. Inthe Models tree view, select the Info Cube OFI AP_C20 Vendor Bal ances

datastore from the SAP BWSource model.

4. Drag this datastore into the sources area of the Logical diagram (left area of the

Logical diagram).

5. Perform the same operation for the Info Object's main table OCREDI TOR Vendor
and text table TXT_OCREDI TOR Texts: Char. Vendor datastore from the SAP BW

Sour ce model.

6.1.6.3 Define Joins between Sources (Info Cube & Object)

THETH

To create joins between the source datastores of a mapping:

1. Inthe Sources area of the Logical diagram drag the

| OPK_OFI AP_C202_0CREDI TOR_PK_VENDCR attribute from the Info Cube OFI AP_C20
Vendor Bal ances datastore onto the VENDCR attribute in the Info Object's main
table OCREDI TOR Vendor . This defines the first join on the Vendor Key identifier, as

shown below:

OCREDITOR
VENDOR
PCOMPANY B T¥T_OCREDITOR
PHONE G+ VENDOR
PLANT = TXTMD

POBOX

POBOX_LOC

E

OFIAP_C20
ICPK_OFIAP_C201_OCOMP_CODE_PK_COMP_CODE
IOPK_OFIAP_C202_OCREDITOR_PK_WENDOR
ICOPK_OFIAP_C202_ORC_ACCOUNT_PK_GL_ACCOUNT
IOPK_OFIAP_C202_OCHRT_ACCTS_PK_CHRT_ACCTS
IOPK,_OFIAP_C203_OCURT'YPE_PK_CURTYPE
IOPK_OFIAP_C20T_OFISCPER_PK_FISCPER —
IOPK_OFIAP_C20T_OFISCYARNT_PK_FISCVARNT
IOPK_OFIAP_C20T_OFISCYEAR_PK_FISCYEAR
IOPK_OFIAP_C20T_OFISCPER3_PK_FISCPER3
IOPK_OFIAP_C20U_DCURRENCY_PK_CURRENCY
REQUID
KF_ODEBIT

JOIN

2. In the Properties panel, you can see the join clause:
OFI AP_C20. | OPK_OFI AP_C202_0CREDI TCR_PK_VENDOR=0CREDI TOR. VENDOR

ORACLE

JOINT
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In the Properties panel, select Generate ANSI Syntax and Join Order options,
and make sure that Execute on Hint option is set to Source as shown below:

JOIM - Propetties

Q, Find

= Condition

OFIAP_C20.I0PE OFIAP C201 OCOMP_CODE_PE COMP_CODE = OCREDITOR. VENDOR
Join Condition:

Cross Matural
OFLAP_CZOMOFIAP_C20)  [] []  OCREDITOR{OCREDITOR)

Jain Type:
P Inner Join

Al rows paired by the join condition between OFIAP_C20(0FIAP_C20) and OCREDITOR(OCREDITOR)

Technical Description: | |

Fenerate ANSI Synta:

Join Order: User Defined: |ID |

Execute on Hink: |Source '|

Make sure that table number of OFI AP_C20 is smaller than that of 0CREDI TOR. In 1:n
relationships the parent data target has to be the first in a join.

Change join between OFI AP_C20 and OCREDI TCR to left outer join (All rows from
OFI AP_C20 and matching ones from 0CREDI TOR.

Change join between 0CREDI TOR and TXT_OCREDI TOR to left outer join (All rows
from OCREDI TOR and matching ones from TXT_0CREDI TOR.

6.1.6.4 Create the Mappings

To create the mappings of the target datastore:

1.
2.

Select the COVP_CODE attribute from the target datastore.

Drag the | OPK_OFI AP_C201_0COVP_CCDE_PK_COWP_CCDE attribute from the
OFI AP_C20 Vendor Bal ances source data target onto the COVP_CODE attribute of
the target datastore.

Make sure that the Execute on Hint option is set to Source. The mapping should
look as shown below:

COMP_CODE - Properties

Q, Find

=] Target

Expression:

Execute an Hink:

ORACLE

OFIAF_C20.I0PKE_OFIAF C20l OCOMP_CODE_PE_COMP_CODE

| Source o |

Fixed Execution Location: | v|
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4. Repeat this operation to perform the following simple mappings:

«  W.VENDER CUBE_OBJ_DS. VENDCR =
OFI AP_C20. | OPK_OFI AP_C202_OCREDI TOR_PK_VENDOR

W VENDER CUBE_OBJ_DS. G._ACCOUNT =
OFI AP_C20. | OPK_OFI AP_C202_ORC_ACCOUNT_PK_GL_ACCOUNT

W VENDER CUBE_OBJ_DS. SALES_FOR PERI OD = OFI AP_C20. KF_OSALES
W VENDER CUBE_OBJ_DS. CUM BALANCE = OFI AP_C20. KF_OBALANCE
W VENDER CUBE_OBJ DS. PLANT = OCREDI TOR. PLANT

W VENDER CUBE_OBJ_DS. MEDI UM DESC = TXT_OCREDI TOR TXTMD

6.1.6.5 Define the Mapping Flow

'

£

AFIAP_C20

=

ACREDITOR

ORACLE

To define the mapping flow:

1. Select the Physical diagram. The Flow diagram looks as shown below:

SOURCE_GROUP

LOGICAL_SAP_BW_UNIT

|
"1 TARGET_GROUP
T¥T_OCREDITOR
® ODI_SAP_DEMO_UNIT
B
JOIN -5 , =
o JOINT_AP W_VENDER_CUBE_OB.J_DS_
JOIN

2. Inthe target group, select the access point for the source group that contains both
the I nf o Cube and Info Object tables. This source group represents the source
dataset made up of two joined SAP BWdata targets.

3. Inthe Property panel, under Loading Knowledge Module, select LKM SAP BWt o
Oracl e (SQLLDR) or LKM SAP BWto SQL from the Loading Knowledge Module
drop-down list.

4. In the Property panel, select the target Oracle database, which is also used as the
staging area for this mapping.

5. Inthe Property panel, under Integration Knowledge Module, select | KM Or acl e
I ncrenental Updat e from the Integration Knowledge Module drop-down list.

6. Setthe IKM options as follows:
a. Select No for the FLOW_CONTROL option.
b. Leave other options as they are.

7. From the File menu, click Save and close your mapping.
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6.1.7 Info Cube Extraction with Navigational Attributes

This section describes how to create a mapping in ODI in order to load data from
a SAP InfoCube and its navigation attributes. The data is extracted from Info Cube
0SD_(04 and InfoObject 0SOLD_TO.

6.1.7.1 Create the Mapping

1. Open Designer.

2. Inthe Projects tree view, expand the SAP BW Denp Project.
3. Expand the SAP_BW Dat aTar get s folder.

4. Select the Mappings node.

5. Right-click and select New Mapping.

6

In the Mapping Definition tab, enter the mapping name:
I nf oCube_I nf oCbj ect _Nav_j oi n. 0SD_C04.

7. From the File menu, click Save to save your mapping.

6.1.7.2 Define the Source and Target Datastores

To define the source and target datastores:

1. Inthe Models tree view, select the 0SD_C04 datastore from the Oracle Target
Model TARGET_NAVI GATI ONAL ATTRI BUTES.

2. Drag this datastore into the targets area of the Logical diagram (right area of the
Logical diagram).

3. Inthe Models tree view, select the Info Cube 0SD_C04 Del i very service
dat ast or e from the SAP BWSource model.

4. Drag this datastore into the sources area of the Logical diagram (left area of the
Logical diagram).

5. Perform the same operation for the Info Object main table 0SCLD_TO Cust oner
dat ast or e from the SAP BWSource model.

6.1.7.3 Define Joins Between Sources (Info Cube & Info Object)

The join between InfoCube and InfoObject will automatically be added by ODI. - There
may be situations when more than one join shows up. E.g. when the same InfoObject
is referenced more than once in different characteristics. Such unwanted extra joins
have to be removed.

The final join setup with its join expression should look like this:
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= 0SD_C04
IOPK_0SD_CO41_0SOLD_TO_PK_CUSTOMER &
IOPK_0SD_C041_0SOLD_TO__OBPARTNER_PK_BF.
IOPK_0SD_CO41_0CUST_GROUP_PK_CUST_GROU M
IOPK_0SD_C041_0SHIP_TO_PK_CUSTOMER E
IOPK_0SD_C042_OPLANT_PK_PLANT
IOPK_0SD_C042_0STOR_LOC_PK_STOR_LOC
IOPYK_0SD_CD44_OMATERIAL_PK_MATERIAL
IOPK_0SD_CD47_0SALESORG_PK_SALESORG
IOPK_0SD_CO4T_OCALDAY_PK_DATED S
IOPK_0SD_CO4T_OCALMONTH_PK_CALMONTH  mi
IOPK_0SD_CO4T_OCALWVEEK_PK_CALWEEK B
IOPK_0SD_CO4T_OFISCPER_PI_FISCPER
IOPK_0SD_CO4T_OFISCYARNT_PK_FISCVARNT
IOPK_0SD_C04U_0VOLUMEUNIT_PK_UNIT
IOPK_0SD_CO4U_DUNIT_OF WT_PK_UNIT
IOPK_0SD_C04U_DBASE_UOM_PK_UNIT
IOPK_0SD_C04U_OSALES_UNIT_PK_UNIT
IOPK_0SD_C047_ODISTR_CHAN_PK_DISTR_CHAN

TETHTETH

0

JOIM

= 0SOLD_TO

® @~ CUSTOMER
POBOX
PLANT
PHONE
PCOMPANY
OUTL_TYPE
NIELSEN_ID
NAME3
NAMEZ
NAME

All InfoObject joins for retrieving navigation attributes must be executed on *staging*
area. Not on source:
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JOIM - Properties
Q, Find ¢

[=] Condition

ol

03D _C04,I0PE 03D CO41 0S0LD TO_PE CUSTOMER = 030LD TO.CUSTOMER
Join Condition:

Cross Makural
0sD_CO040050_C04) [ ] 0S0OLD_TO0SOoLD_TO)
Jain Type: -
Inner Jain

Al rows paired by the join condition betbween 0S0D_CO4(050_C04) and 0S0OLD_TO0SOLD_TO)

Technical Description: | |

Generate ANST Syntax:

Join Order: |
Execute on Hink: |Staging i
6.1.7.4 Create the Mappings

To create the mappings of the target datastore:

1. Dragthe 0SD_C04.1OPK_0SD C041_0SOLD TO PK_CUSTOMER attribute from
the 0SD_C041 Delivery service Source data target onto the
IOPK_0SD_C041_0CUST_GROUP_PK_CUST_GROUP attribute of the target
datastore.

2. Make sure that the Execute on Hint option is set to Source. The mapping should
look as shown below:

IOPKCUST_GROUP_PK_CUST_GROUR - Properties
Q, Find
=] Target
030_C04. I0PKE_03D_CO41 0OCUST_GROUP_PE_CUST GROUP

Expression:
Execute on Hint: |50urce "|
Fixed Execution Location: | vl
S L R B [ 1

3. Repeat this operation to perform the following simple mappings:
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=] Attributes
Attributes:

Marme

IO _CUSTOMER,
TOPK_CALMONTH
TOPKCALWEEK
TOPK_0SPOINT
REQUID
KF_ODEL_WoL
KF_OSHIPDATE
KF_OLOADDATEE
KF_OACT_GL_DTE
KF_OMATAY_DATE
KF_OLATE_QTY
CLSTOMER.

IOPE_DSCUSTOMER,
IOPKCUST_GROUP_PK_CUST_GROUP

Expression

Q

050_C04.I0PK_05D_C041_050LD_TO_PK_CLSTOMER:
050_C04.I0PK_0SD_C041_DCUST_GROUP_PK_CUST_GROUP
050_C04.10PK_05D_C041_OSHIP_TO_PE_CLSTOMER
050_C04.10PK_050_C04T_DCALMONTH_PK_CALMONTH
050_C04.10PK_050_C04T_DCALWEEK _PK_CALWEEE
050_C04.10PK_050_C042_0SHIP_POINT_PK_SHIP_POIMT
050_C04.REQUID
050_C04.KF_0DEL_YOL
050_C04.KF_0SHIFDATE
050_C04.KF_OLOADDATEK
050_C04.KF_0ACT_GI_DTK
050_C04.KF_OMATAY_DATE
050_C04.KF_OLATE_GTY
050L0_TS, CLSTOMER

POBOX
FLANT
FHOME
PCOMPANY

QUTL
LAMNG

_TYPE
U

6.1.7.5 Define the Mapping Flow

030LD_To, POBON
0S0LD_To PLANT
030LD_To, PHOME

0S0LD_ToO, PCOMPARNY
0S0LD_To, OUTL_TYPE

0S0LD_Tio, LAMGU

To define the mapping flow:

1.

Select the Physical diagram. The Flow diagram appears as follows:

7Y SOURCE_GROUP

4 LOGICAL_SAP_BW_UI

i

ASOLD_TO

[

ASD_C04

ORACLE

vy
®

ASOLD_TC

| A ] Y

ASD_C04_

ODI_SAP_DEMO_UNIT

TARGET_GROUP

N

[

TARGET_NAWVIGATIONAL_ATTRIBLTE

In the target group, select the access points for the ODI Source Datastores.
In the Property panel, verify that LKM SAP BWto Oracle (SQLLDR) or LKM SAP BW

to SQ has been set for every ODI Source Datastore.
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< Note:

This mapping will generate several SAP ABAP extraction programs. One
for retrieving any display attributes and key figures from the InfoCube
and one for each InfoObject containing navigation attributes.

4. In the target group, select the target Oracle database, which is also used as the
staging area for this mapping.

5. In the Property panel, under Integration Knowledge Module, verify that IKM SQL
Control Append has been set for the target datastore.

6. Execute the Mapping. Verify that Info Cube and Navigational attributes got
populated into the target datastore.

6.1.8 Open Hub Extraction

This section describes how to create a mapping in ODI in order to load data from
a SAP BW source model representing the Open Hub destination ZOHD _SALE (/BI T/
OHZOHD _SALE) to the W OPENHUB_SALES DS Oracle target model.

6.1.8.1 Create the Mapping

Open Designer.

In the Projects tree view, expand the SAP BW Denp Project.
Expand the SAP_BW Dat aTar get s folder.

Select the Mappings node.

Right-click and select New Mapping.

e o p W NP

In the Mapping Definition tab, enter the mapping name:
penHub_Sal es. W OPENHUB_SALES DS.

7. From the File menu, click Save to save your mapping.

6.1.8.2 Define the Source and Target Datastores

To define the source and target datastores:

1. Inthe Models tree view, select the W OPENHUB_SALES DS datastore from the
Oracl e_Target Model.

2. Drag this datastore into the targets area of the Logical diagram (right area of the
Logical diagram).

3. Inthe Models tree view, select the ZOHD SALE datastore from the SAP BW Sour ce
model.

4. Drag this datastore into the sources area of the Logical diagram (left area of the
Logical diagram).

6.1.8.3 Create the Mappings

To create the mappings of the target datastore:
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1. Select the CHREQUI D attribute from the target datastore.

2. Drag the OHREQUI D attribute from the ZOHD SALE source data target onto the
OHREQUI D attribute of the target datastore.

3. Make sure that the Execute on Hint option is set to Source. The mapping should
look as shown below:

OHREEQUID - Propetties
Q, Find i
=] Target

=l

Z0HD SALE . COHREQUID
Expression:

Execute an Hink: |S|:|ur|:e "

- - .- . .- [ 1
4. Repeat this operation to perform the following simple mappings:

*  WOPENHUB_SALES DS. DATA_PACKAGE = ZOHD_SALE. DATAPAKI D

* W OPENHUB_SALES_DS. DATA RECORD = ZOHD_SALE. RECORD

e WOPENHUB_SALES DS. CUSTOMER = ZOHD_SALE. D CUSTOMER

e WOPENHUB_SALES DS. MATERI AL = ZOHD_SALE. D_MATERI AL

WOPENHUB_SALES DS. MATERI AL_PRI CE = ZOHD SALE. PRI CE_NAT

e WOPENHUB_SALES DS. CURRENCY = ZOHD_SALE. CURRENCY

e W OPENHUB_SALES DS. QUANTI TY = ZOHD_SALE. /BI T/ ZQTY

*  WOPENHUB_SALES DS. TOTAL_REVENUE = ZOHD SALE./BI C/ ZREV

6.1.8.4 Define the Mapping Flow

ORACLE

To define the mapping flow:

1. Select the Physical diagram. The Flow diagram looks as shown below:

oy TARGET_GROUP
$3. SCURCEICAOE ® ODI_SAP_DEMO_UNIT
<= LOGICAL_SAP_BW_LI
i =
= et
ZOHD_SAL W_OPENHUE_SALES_DS_
ZOHD_SALE
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In the target group, select the access point for the source group that contains
Open Hub Destination Table ZOHD _SALE. This source group represents the source
dataset made up of SAP BWOpen Hub table.

In the Property panel, under Loading Knowledge Module, select LKM SAP BWt o
Oracle (SQLLDR) or LKM SAP BWto SQ. from the Loading Knowledge Module
drop-down list.

In the target group, select the target Oracle database, which is also used as the
staging area for this mapping.

In the Property panel, under Integration Knowledge Module, select | KM Oracl e
I ncrenmental Updat e from the Integration Knowledge Module drop-down list.

Set the IKM options as follows:
a. Select No for the FLOW_CONTROL option.
b. Leave other options as they are.

From the File menu, click Save and close your mapping.

6.2 Running the Mapping

This section contains the following topics:

Running the Mapping
Review the Mapping Execution

Review the Resulting Data

6.2.1 Running the Mapping

To run the mapping:

ORACLE
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In the Projects tree view, expand the SAP Denp Project

Expand the SAP_BW Dat aTar get s folder.

Expand the Mappings node.

Select the | nf oCube_SAP_BW Vendor Bal . W VENDR_BAL_DS mapping.
Right-click and select Run.

In the Execution window that appears, click OK.

Click OK in the Session Started window.

What happens when you run the mapping?

First, Oracle Data Integrator creates an ABAP program that does the following:

1.

It performs the extraction of the data on the SAP BW system. In this example,
the extraction will be done on Info Cube source data targets and then returns the
resultset in an extraction file.

It uploads the extraction file into a FTP data server. This FTP host is specified via
the File Logical Schema called File Server for SAP ABAP. This Logical Schema is
mapped to a Physical Schema and therefore a data server in the given context.
This data server contains the connection information for the FTP host.
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Then, the ABAP code is uploaded using the OdiSapAbapExecute tool.

The ABAP program is pushed into the SAP Function group given in the
SAP_FUNCTION_GROUP_NAME LKM option. This phase can be suppressed by
setting the UPLOAD_ABAP_CODE LKM option to No.

The ABAP code is executed also by the OdiSapAbapExecute tool. At the end of the
ABAP code execution, the extraction file is available in the FTP host.

The Oracle Data Integrator agent is able to download this extraction file from the FTP
host, or directly access it, depending on the FTP_TRANSFER_METHOD specified in
the IKM option.

Finally, when the agent accesses the extraction file, it uses SQL*Loader or a JDBC
Connection to load this file into the Oracle/non-Oracle staging area. The rest of the
integration process takes place within the Oracle/non-Oracle engine.

6.2.2 Review the Mapping Execution

To review the mapping execution:

Connect to Operator.

In the Operator, select the Session List tree view.
Expand the All Executions node in this tree view.
The latest session is the first entry of this list.

Double click the | nf oCube_SAP_BW Vendor Bal . W VENDR_BAL_DS node to see the
session details and the number of lines processed.

@ H w0 b P

6.2.3 Review the Resulting Data

To review the resulting data:

1. Inthe Designer, in the Models tree view, expand the Or acl e Target Model.

2. Select the W VENDR BAL_DS datastore, right-click and select Data to view the data
integrated into the target Oracle table.

3. Repeat the same steps for remaining mappings:
* InfoQhject_SAP_BW Vendor Acc. W ACCNT_VENDR DS
< ODS_SAP BW PurchOrdl . W PURCH DS
e InfoCube_InfoChject join WVENDER CUBE OBJ DS
e (OpenHub_Sal es. W OPENHUB_SALES DS
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This chapter describes how to create a package for delta extraction.

So far we have seen examples of extracting data from BW data targets. The
instructions in this chapter explain how the mappings introduced in the previous
chapters can be turned into delta extraction mappings.

In delta extraction mappings only the data, which was changed after last extraction, is
extracted. Delta extraction mappings are only supported for InfoCubes, ODS/DSO and
Open Hub objects, but not for InfoObjects.

This chapter includes the following sections:

Modify the Mapping Flow
Creating the MIN_REQUEST _ID Variable
Creating a Package for Delta Extraction

Running the Package

7.1 Modify the Mapping Flow

The first step is to modify the mapping:

ORACLE
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Select the desired Mappings.

Double click the mapping.

Select the Physical diagram.

In the target group, select the access point for the source group.

In the Property panel, under Loading Knowledge Module, set KM option
values for FIRST_REQ_ID to #M N_REQUEST | Dand LAST_REQ_ID to
<@odi SAPBWDel t aRef . get Last Or MaxReql d() @ as shown below.
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Loading Knowledge Module: |LKM SAP BYW to Oracle (SQLLDR)

Shyle: |Temp|ate-sty|e

Options Descripkion

Ciptions:

Iame

----- SAP_TRANSPORT_REQUEST_DESC
----- DATAFILE_PER,_SESSION

----- SAP_REPORT_MAME_PREFTX

----- TRUNCATE_COHD_AFTER_EXTRACTION
----- CHECK_D@TA_FOR_DELIMITERS
----- UPDATE_LAST_REGQID

----- FIRST_REQ_ID

----- LAST_REQ_ID

----- PROCESS_CHAIN

----- FILE_FORMAT

----- FIELD_SEPARATOR.

----- FTP_TRAMSFER_METHOD

----- SOL_BASED_EXTRACTION

----- FTP_PASSIYE_MODE

----- FILE_TRANSFER_TIMECUT

Description

SAP Transpork Request Desc
Allowe per session file name
Prefiz of grouped ABAP Reports
Flag ko indicate ko truncate
Checks delimiter char in data value
Max Request ID Fetch Flag
Skart point of Delta Extraction
End point of Delta Extraction
(Open Hub Process Chain Mame
Delimited Yalue

Colurn Seperator

Data Transfer Method

Twpe of extraction Far Hierarchy
FTP Mode

FTP Time out time

juny
@
T

cpeesee

I

Yalue
ODL: < %=odiRef . getStep{"STEP_MAME")%: >
False

False
True

]
5

-
&
]
o
a,
o
c

#MIN_REGUEST_ID
<@=0diSAPEWDEltaRef, EetLastOrMaxReaE()@>

DELIMITED
“@=""+{char}3@=
FTR

False

True

100000

6. From the File menu, click Save and close your mapping.

7.2 Creating the MIN_ REQUEST _ID Variable

The second step consists of creating an ODI variable that stores the last extracted
request ID. This request ID serves as the starting point for the next extraction run:

1. Create a MIN_REQUEST _ID variable to hold the last request id. The

MIN_REQUEST _ID variable has to be a numeric variable with a Keep Hi story

or Last - val ue Action as shown below.

Y MIN_REQUEST_ID

Definition 9 Variable [Proj o
Refreshing | 1 variable [Project: SAP BW Demo]
History MName: [MIN_REQUEST_ID
Rlerices Datatype: |'Numeric v
Memo !
Version Keep History: |AII Values 4
Privileges Secure Value: [
Default Value: D
Description:
Start Point of Infocube Delta Extraction
Owerview
—

2. The value of this variable is updated at the end of the delta extraction package
described in the third step. It happens once delta extraction is finished and the
MAX REQUEST ID will be fetched from SAP BW system and will be stored into
the ODI Variable (MIN_REQUEST_ID). The refresh expression shown here is
used to update the variable:

ORACLE

FEREFEEOORERERE
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U MIN_ REQUEST_ID

Definition . - —
- Schema: | SUNOPSIS_MEMORY_ENGINE
Refreshing

Histary Select Query: EE} 4 /

Markers Select «@=0diSAPBWDelkaRef .getLastOrMaxReqld()@ >FROM DUAL
Memo

Version

Privileges

Cverview

7.3 Creating a Package for Delta Extraction

In the third step the building blocks created in the previous steps are put together:
Variable and Mappings are arranged into a Package:

1. Open the SAP Denp Project.
2. Create a new Package named SAP Deno.
3. Insert a Declare Variable step to this Package:

Drag and Drop the M N_REQUEST | D variable and select the "Declare Variable" step
type.

4. Insert a Flow step to this Package:

Drag and drop the Mapping created in the previous sections for InfoCube/ ODS or
OpenHub-Extraction in the Package.

5. Insert a Refresh Variable step to this Package.

Drag and Drop the M N_REQUEST _| D variable and select the "Refresh Variable" step
type.

6. Define the step sequence.
a. Define the Declare Variable step as the First Step.
b. Link it to the Flow step that is the next step upon success.

c. Link the Flow step to the Refresh Variable step that is the next step upon
success and the last step in the Package. Add arrows between the variables.

Your Package should look as shown on this screenshot.
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7.4 Running the Package

To run the Package:

ORACLE

Step name Type
MIN_REQUEST_ID | [Refresh variable |
Linked object Path
MIN_REQUEST_ID | [[5ap BW Demo)

In the Projects tree view, expand the SAP Denp Project.
Select the SAP Denp Package.

Right-click and select Run.

In the Execution window, click OK.

In the Session Started window, click OK.

What happens when you execute the delta extraction Package?

First, Oracle Data Integrator initializes the variable MIN_REQUEST _ID with the

last historized value (declare variable step). This value is then passed into ABAP
extraction program to specify where to start the data extraction. The KM queries the
SAP system for the highest assigned request ID. All data between min and max

request ID will be extracted (mapping).

After the execution of the mapping the refresh variable step stores the highest request
ID into MIN_REQUEST _ID for next extraction run.
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Going Further with Oracle Data Integrator

This chapter describes what steps to take next with Oracle Data Integrator.
You have now completed a Project extracting data from a SAP BW system.

In this Project, you have:

Set up the environment and topology to work with SAP BW.
Created and reverse-engineered a SAP BW data model.

Created different mappings to load the data from Info Cube, Info Object, ODS/
DSO, Info Cube & Info Object join, Open Hub destination table, Delta SAP BW
data targets & tables into the Oracle database.

Refer to individual KM options and their descriptions as well as to Considerations for
SAP BW Integration in Application Adapters Guide for Oracle Data Integrator for more
information on the SAP BW KM features and options.

< Note:

In case the execution did not complete successfully, please check the ODI
Operator and ODI Logs for details. In addition to this, the following log files
will contain execution information.

e <SystemTenp Dir or local FTP dir>/ ZODl _<Mapping
| d> <SrcSet>_<Cont ext >. out

e <SystemTenp Dir or local FTP dir>/ ZODl _<Mapping
| d>_<SrcSet> <Context>.err

Refer to Log Files in Application Adapters Guide for Oracle Data Integrator
for more details.

8.1 Going further with Oracle Data Integrator

Use the demonstration environment to familiarize yourself with Oracle Data Integrator.
You can go further with Oracle Data Integrator by taking advantage of the samples
available on the Oracle Technology Network.

ORACLE
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SAP ABAP BW Required Privileges

This appendix lists the required privileges for accessing the SAP system using Oracle
Data Integrator.

For connecting to the SAP system a SAP dialog user is required for RKM installation
and LKM execution during development. A SAP RFC user is not sufficient.

This user has to have a developer license key. License keys can be retrieved from
http://service.sap.com. Any execution attempts without this developer license key will
lead to failure and may cause the need for clean-up operations.

Later for RKM execution and LKM execution in production a SAP RFC user is
sufficient.

These SAP user types can be used for the following operations:

Table A-1 Required SAP User Types
]

Operation Required SAP User Type

RKM: Setup SAP Dialog user

RKM: Reverse Engineering SAP Dialog user or SAP RFC user
LKM: Development SAP Dialog user or SAP RFC user
LKM: Production SAP Dialog user or SAP RFC user
Testing ODI Generated Extraction RFCs SAP Dialog user or SAP RFC user

The following tables list the privileges required for using SAP BW Knowledge Modules:
e Authorizations Required for RKM SAP BW Upload

e Authorizations Required for RKM SAP BW Execution

e Authorizations Required for LKM SAP BW Upload (Background & Foreground)

e Authorizations Required for LKM SAP BW Execution (Background & Foreground)

A.1 Important points to consider

Consider the following points while configuring the SAP privilieges:

 S_DATASET is an authorization object that controls access to physical file, so
you need to provide access to SAP directories & folder mounted path. The values
provided here are sample paths, you need to provide your landscape directories
path or provide *(all).

* NRor (NR) means NOT REQUIRED.
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Appendix A

Authorizations Required for RKM SAP BW Upload

A.2 Authorizations Required for RKM SAP BW Upload

The following SAP authorizations are required, only in rare cases when explicitly
requested by Oracle product support. For standard installations, these authorizations

ORACLE

are not required.

# Note:

Developer Key is required in this authorization.

Object Field Name Value (Bl 7.0) Value (Bl 7.5)
S RFC ACTV 16 16
S RFC RFC_NAME RFCL, RSAB, RFC1, RSAB,
RSB3RD, RSB3RD,
SDI FRUNTI ME, SDI FRUNTI ME,
SUTL, SYST, SYSU, SUTL, SYST,
ZODl * SYSU, zODi*,
RSBAPI _1 OBJ
S RFC RFC _TYPE FUGR FUGR
S_RFCRAI AR RFC_RAI AR NR 16
S _TCODE TCD SU53, SE38 SU53, SE38
S ADM _FCD S ADM _FCD RFCA RFCA
S CTS_ADM CTS_ADMFCT TABL TABL
S _DATASET ACTV 06, 33, 34 06, 33, 34, A7
S DATASET FI LENAME * *
S _DATASET PROGRAM SAPLSLOG, *
SAPLSTRF,
SAPLZODI *
S TABU DI S ACTV 3 2,3
S TABU DI S DI CBERCLS * *
S DEVELOP ACTV 01, 02, 03,06, 07,16 01,02,03, 06,07, 16
1 701 I\M ) 70, I\M
S _DEVELCOP DEVCLASS $TMP, ZODI _LKM PCK $TMP, ZODI _LKM PCK
G ZODI _RKM PCKG, R G ZODI _RKM PCKG R
SS, zODl * SS, zODl *
S _DEVELOP OBINAME * *
S DEVELOP OBJTYPE FUGR, PROG, DEVC, DE *
BUG
S _DEVELOP P_GROUP * *
S _TRANSPRT ACTV 01, 02,03 01, 02,03
S_TRANSPRT TTYPE DTRA, TASK DTRA, TASK
S _RS_ADWB ACTV 03, 16 03, 16
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Authorizations Required for RKM SAP BW Execution

Object Field Name Value (Bl 7.0) Value (Bl 7.5)
S RS ADM/AB RSADMABOBJ | NFOOBJECT | NFOOBJECT
S RS_| CUBE ACTVT 03 03

S_RS | CUBE RSI CUBECOBJ * *

S RS | CUBE RSI NFOAREA * *

S RS | CUBE RSI NFOCUBE * *

S RS 10BJ ACTVT 03 03

S RS 10BJ RSI OBJ * *

S RS 10BJ RSI OBJCAT * *

S RS |1 CBJ RSI OBJPART DEFI NI TI ON DEFI NI TI ON
S_RS ODSO ACTVT 03 03

S RS ODSO RSI NFOAREA * *

S_RS _ODSO RSODSOBJ * *

S_RS _ODSO RSODSPART DATA, DEFI NI TI ON DATA, DEFI NI TI ON

A.3 Authorizations Required for RKM SAP BW Execution

The following authorizations are required for RKM SAP BW execution.

ORACLE

Object Field Name Value (BI 7.0) Value (BI 7.5)

S RFC ACTVT 16 16

S RFC RFC_NAME RFC1, RSAB, RFC1, RSAB, RSB3RD,
RSB3RD, SDI FRUNTI ME, SUTL,
SDI FRUNTI ME, SUTL, SYST, SYSU, zQDl*,
SYST, SYSU, zCDi* RSBAPI _| OBJ

S RFC RFC_TYPE FUR FUGR

S_TCCODE TCD SUs3 SUs3

S_DATASET ACTVT 06, 33, 34 06, 33, 34

S _DATASET FI LENAMVE * *

S_DATASET PROGRAM SAPLSTRF, SAPLSTRF, SAPLSLOG
SAPLSLOG, SAPLZODI *
SAPLZQDI *

S TABU DI S ACTVT 03 03

S TABU DI S DI CBERCLS * *

S_TRANSPRT ACTVT 01, 02, 03 01, 02, 03

S_TRANSPRT TTYPE DTRA, TASK DTRA, TASK

S RS ADMB ACTVT 03,16 03,16

S_RS_ADMB RSADMABOBJ * *

S_RS | CUBE ACTVT 03 03

S RS | CUBE RSI CUBECOBJ DATA, DEFINITION  DATA, DEFINITION
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Authorizations Required for LKM SAP BW Upload (Background & Foreground)

Object Field Name Value (Bl 7.0) Value (Bl 7.5)
S RS | CUBE RSI NFOAREA * *

S RS_| CUBE RSI NFOCCUBE * *

S RS 10BJ ACTVT 03 03

S RS I OBJ RSI 0BJ * *

S RS I0BJ RSI OBJCAT * *

S RS 10BJ RSI OBJPART DEFI NI TI ON DEFI NI TI ON
S_RS _ODSO ACTVT 03 03
S_RS_0ODSO RSI NFCAREA * *

S_RS_ODSO RSODSOBJ * *

S_RS ODSO RSODSPART DATA, DEFINITION  DATA, DEFINITION
S RS AUTH Bl AUTH 0* 0*

A.4 Authorizations Required for LKM SAP BW Upload
(Background & Foreground)

The following authorizations are required for LKM SAP BW execution in a SAP
development environment.

ORACLE

" Note:

Developer Key is required in this authorization.

This section contains authorizations for both background and foreground executions.

Object Field Name Value (BI 7.0) Value (BI 7.5)
S RFC ACTVT 16 16
S RFC RFC_NAMVE RFCL, RFCL,
SDI FRUNTI ME, SDI FRUNTI ME,
SLST, SYST, zODi* SLST, SYST, zODI*
S RFC RFC_TYPE FUR FUR
S _TCODE TCD SE38, SU53 SE38, SU53
S DEVELCP ACTVT 1, 2, 3, 6, 7, 16 1, 2, 3, 6, 7, 16
S DEVELCOP DEVCLASS * *
S DEVELCOP OBJINAME * *
S DEVELCP OBJTYPE FUGR, FUNC, FUGR, FUNC,
PROG*, SUSO PROG*, SUSO
S DEVELCOP P_GROUP NR NR
S _PROGRAM P_ACTI ON BTCSUBM T, BTCSUBM T,

SUBM T, VARI ANT

SUBM T, VARI ANT
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Authorizations Required for LKM SAP BW Execution (Background & Foreground)

Object Field Name Value (Bl 7.0) Value (Bl 7.5)
S_PROGRAM P_GROUP NR NR

S_TRANSPRT ACTVT 1, 2, 43 1, 2, 43
S_TRANSPRT TTYPE DTRA, TASK DTRA, TASK

S TABU D' S ACTVT 3 3

S TABU DI S DI CBERCLS * *

S_BTCH ADM BTCADM N Y Y

S_BTCH JOB JOBACTI ON RELE RELE

S_BTCH JOB JOBGROUP © ©

S CTS_ADM CTS_ADMFCT TABL TABL

S_DATASET ACTVT 06, 33, 34 06, 33, 34
S_DATASET FI LENAVE * *

S _DATASET PROGRAM * *

S RS _AUTH Bl AUTH * *

S RS | CUBE ACTVT 3, 6 3, 6

S RS | CUBE RSI CUBECBJ DATA, DEFINITION DATA, DEFIN TION
S_RS | CUBE RSI NFOAREA * *

S RS | CUBE RSI NFOCUBE * *

S RS 10BJ ACTVT 3 3

S RS 10BJ RSI 0BJ * *

S RS 10BJ RSI OBJCAT * *

S RS 10BJ RSI OBJPART DATA, DEFINITION DATA, DEFIN TION
S_RS _ODSO ACTVT 3 3

S_RS _ODSO RSI NFOAREA * *

S RS ODSO RSODSOBJ * *

S_RS _ODSO RSCDSPART DATA, DEFINITION DATA, DEFIN TION
S_APP_LGOG ACTVT 03, 06 03, 06

S APP_LOG ALG_OBJECT * *

S APP_LOG ALG_SUBOBJ * *

A.5 Authorizations Required for LKM SAP BW Execution
(Background & Foreground)

The following authorizations are required for LKM SAP BW execution in a SAP
production environment.

This section contains authorizations for both background and foreground executions.
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Authorizations Required for LKM SAP BW Execution (Background & Foreground)

Object Field Name Value (Bl 7.0) Value (Bl 7.5)

S RFC ACTVT 16 16

S RFC RFC_NAME RFCL, RFCL,
SDI FRUNTI ME, SDI FRUNTI ME,
SLST, SYST, SLST, SYST,
ZODl _FGR_PROD* ZODI _FGR_PROD*

S RFC RFC_TYPE FUR FUR

S_TCCODE TCD SU53 SU53

S TABU DI S ACTVT 3 3

S TABU DI S DI CBERCLS * *

S_BTCH ADM BTCADM N Y Y

S BTCH JOB JOBACTI ON RELE RELE

S_BTCH JOB JOBGROUP © ©

S_DATASET ACTVT 06, 33, 34 06, 33, 34

S_DATASET FI LENAVE * *

S _DATASET PROGRAM * *

S_TRANSPRT ACTVT 1, 2, 43 1, 2, 43

S_TRANSPRT TTYPE DTRA, TASK DTRA, TASK

S_RS_AUTH Bl AUTH * *

S_RS | CUBE ACTVT 3, 6 3, 6, 23, 63, 66

S RS | CUBE RSI CUBEOBJ * *

S RS_| CUBE RSI NFOAREA * *

S RS | CUBE RSI NFOCUBE * *

S RS 10BJ ACTVT 3 3

S RS I OBJ RSI OBJ * *

S RS 10BJ RSI OBJCAT * *

S RS 10BJ RSI OBJPART DATA, DEFINITION DATA, DEFINITION

S_RS ODSO ACTVT 3 3

S_RS_ODSO RSI NFOAREA * *

S_RS _ODSO RSODSOBJ * *

S_RS _ODSO RSODSPART DATA, DEFINITION DATA, DEFINITION

S APP_LOG ACTVT 03, 06 03, 06

S APP_LOG ALG_OBJECT * *

S _APP_LGOG ALG_SUBOBJ * *

ORACLE
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SAP Stand-Alone Connection Test

This appendix describes how to perform an SAP stand-alone connection test.
In addition to the Connection Testing described above, a test can be performed
outside of ODI using a standalone java utility:

B.1 SAP Stand-Alone Connection Test

To use a standalone java utility to test the connection:

1. Open a command window.

2. Change to <ODI _HOVE>/ odi / sdk/ | i b directory.

3. Make sure that JAVA_HOME points to a JVM (at least 1.5).
4

Make sure that you have installed SAP Java Connector and that the sapjco3.jar
and the sapjcog3 library are in the <ODI _HOVE>/ odi / sdk/ | i b directory.

5. Launch the utility using the following command:
On Windows:
java -cp sapjco3.jar;odi-sap.jar oracle.odi.sap. kmtest.JCoTest
On Linux/UNIX:
java -cp sapjco3.jar:odi-sap.jar oracle.odi.sap. kmtest.JCoTest

This should result in an output similar to this:

CATION: Connect t
{SAP Application Se
on local heost th Unicode
Application Eerver?’ unknown
p B8 16:87:27 288

{network interfacel

&Ii‘ﬂul.llurjl_.ﬂq,lH-ﬂ.nu; "{BAF Application Server?’ not Ffound
ddrinfo

6. Use a text editor to open the ODI_SAP_CON_POOL.jcoDestination file in the
oracledi/drivers directory. The file should look like this:

#for tests only!

jco.client.lang=EN

j co.destination.peak_|inmt=10
jco.client.client=800
jco.client.passwd=<SAP Passwor d>
jco.client.user=<SAP User>
jco.client.sysnr=00

j co. destination. pool capacity=5
jco.client.ashost=<SAP Application Server>
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SAP Stand-Alone Connection Test

7. Enter your SAP connection information, which you have received from your
SAP administrator. The file will then look similar to this (use your connection
information!):

#for tests only !

jco.
jco.
jco.
jco.
jco.
jco.
jco.
jco.

client.lang=EN

destination. peak_|init=10
client.client=800
client.passwd=0Dl 123
client.user=0Dl
client.sysnr=00
destination. pool _capacity=5
client.ashost=123.123. 123. 123.

8. Launch the utility again using the following command:

On Windows:

java -cp sapjcod.jar;odi-sap.jar oracle.odi.sap.kmtest.JCoTest

On Linux/UNIX:

java -cp sapjco3.jar:odi-sap.jar oracle.odi.sap. kmtest.JCoTest

This should result in an output similar to this:

\WINDOWS' system32 cmd.exe

ap.Jjar;sapj jar oracle.odi p.km.test.JCoTest

ting connection Pool...

Hame: null
ibutes: DEST:

_HOS8T:
HER_HOST =
HR:

PARTNER_CHARSET
PARTHER_E
PARNER_BYT
OWN_REL:
PARTNER_REL:

oDl _SAP_CON_POOL

D:s0ralomne_1“oracledisdrivers?

In addition to just testing the SAP connection, the utility will also validate the
existence of certain Function Modules required for the RKM. These are installed
during first execution of the RKM (UPLOAD_ABAP_CCDE and UPLOAD_ABAP_BASE set to
true).

ORACLE
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SAP Stand-Alone Connection Test

9. Delete the ODI _SAP_CON POOL. j coDesti nati on file after execution, as it contains
the SAP login credentials.
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Uninstalling ODI SAP Components

This appendix describes how to uninstall ODI components from your SAP system.
For removing ODI connectivity from the SAP system, please follow the steps
described in this section.

Please note that this will delete ALL components including generated extractor
programs.

C.1 Updating ODI SAP Components

During first-time installation the RKM installs some ODI objects into the SAP system.
This installation consists of two parts: some base objects and some RFCs. Such full
installation requires that no ODI SAP objects are installed in the SAP system. See
Uninstalling ODI SAP Components if needed.

If the ODI objects installed into your SAP systems have been installed by RKM SAP
ERP v34 or later / RKM SAP BW v25 or later, there is no need for reinstalling the base
objects and it is sufficient to update just the RFCs. Reinstalling the RFCs is achieved
by executing a reverse engineering run with RKM option UPLOAD ABAP_BASE set to

fal se and RKM option UPLOAD ABAP_CODE setto true.

C.2 Uninstalling ODI SAP Components

To upgrade to a newer ODI SAP Connector release or to permanently remove the ODI

connectivity:

1. Start the SAP GUL.

2. Connect to the SAP systems you want to uninstall.

3. Go to the transaction SE8O.

4. Select the package or development class option from the drop down box.

5. Enter ZODI _RKM PCKGin the package or development class field. Note that for older

installations the package name is ZODI _DEVCLASS.
Right-click the ZODI _RKM PCKG object below the object name tab.

o

7. Select Delete in the drop down menu and delete the development class.

If it does not allow deleting the development class individually, delete all the
objects inside one by one. For the contained Function Group please make sure
to delete it in one go and do not delete the Function Group's Function Modules
individually. Once all objects have been removed, delete the development class
itself.

8. Go to transaction SE10. Select Modifiable and Workbench Requests. Click
Display.

9. Select the transport requests which have the ODI Objects and Release them.

10. Now repeat the steps 3 to 7 to delete Development Class.
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11. Go to transaction SE01. Select Modifiable and Workbench Requests. Click
Display. Release the Transport Request which has ZODI _RKM PCKG.

12. Repeat Step 4 to 11 for package ZODI _LKM PCKG.
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